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Terms and Conditions

Preface

Thank you for purchasing this Topcon product. The materials
available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. (“TPS”) for owners of Topcon
products and are designed to assist owners with the use of the
product, and its use is subject to these terms and conditions (the
“Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.

TRADEMARKS Net-G3A, Topcon Tools, Topcon Link, TopNET,
Topcon, and Topcon Positioning Systems are trademarks or registered
trademarks of TPS. Windows® is a registered trademark of Microsoft
Corporation. The Bluetooth® word mark and logos are owned by
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Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning
Systems, Inc. is used under license. Other product and company
names mentioned herein may be trademarks of their respective
owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL
OR THE PRODUCT. SUCH DISCLAIMED DAMAGES INCLUDE
BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR
DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR
COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE PRODUCT.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
and Conditions in this Manual and an agreement to abide by these
Terms and Conditions. The user is granted a personal, non-exclusive,
non-transferable license to use such Software under the terms stated
herein and in any case only with a single product or single computer.
You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
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Terms and Conditions

comply with any of the Terms or Conditions. You agree to destroy the
Software and Manual upon termination of your use of the product. All
ownership, copyright and other intellectual property rights in and to
the Software belong to TPS. If these license terms are not acceptable,
return any unused Software and Manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the product. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the product can lead to injury to persons or
property and/or malfunction of the product. The product should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in
accordance with, the laws of the State of California, without reference
to conflict of laws.
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Manual Conventions

This manual uses the following conventions:
Example Description

File » Exit Click the File menu and click Exit.
Connection  Indicates the name of a dialog box or screen.

Frequency Indicates a field on a dialog box or screen, or a tab
within a dialog box or screen.
Enter Press or click the button or key labeled Enter.
-] Further information to note about the configuration,
NOTE maintenance, or setup of a system.

Supplementary information that can help you
configure, maintain, or set up a system.

on system operation, system performance,
measurements, or personal safety.

Notification that an action has the potential to
adversely affect system operation, system
performance, data integrity, or personal health.

[~
i | i
@ Supplementary information that can have an affect

Notification that an action will result in system
damage, loss of data, loss of warranty, or personal
injury.

Under no circumstances should this action be
performed.

WAR

=
>
=
2
2z
=
&
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Introduction

The Net-G3A receiver (Figure 1-1 on page 1-2) is a multi-frequency,
GNSS receiver built to be the most advanced and convenient
reference station receiver available today. The receiver is a dedicated
permanent or semi-permanent reference station intended for precision
markets. Precision markets means markets for equipment,
subsystems, surveying components and software, construction,
commercial mapping, civil engineering, precision agriculture, land-
based construction and agriculture machine control, photogrammetry
mapping, hydrographics, and any use reasonably related to the
foregoing.

The Net-G3A can receive and process multiple signal types
(including the latest GPS L2C, L5, GLONASS C/A L2, and
GALILEO' signals) improving the accuracy and reliability of the
solution, especially under difficult job-site conditions. The following
features combine to provide a positioning system efficient, secure,

and appropriate for any survey or application that requires highly-
accurate timing and positioning solutions:

* GNSS

» Multiple frequency detection

* One-Pulse-Per-Second (1PPS) output and external event time-
tagging

 External frequency input and internal frequency output

» Network connections

Several other features, including multipath mitigation and anti-
jamming suppressor, provide a reliable and versatile reception of
weak signals in degraded signal environments. The receiver provides
the functionality, accuracy, availability, and integrity needed for fast
and easy data collection and management.

1. Contact Topcon Technical Support for detailed information about the
supported GALILEO signals.
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Introduction

Figure 1-1. Net-G3A Receiver

Principles of Operation

Whether based on a single reference station or a network of reference
stations, static and mobile applications that use GNSS data from a
high performance reference station benefit from the highest possible
levels of accuracy and precision.

This section gives an overview of existing and proposed Global
Navigation Satellite Systems (GNSS) and receiver functions to help
you understand and apply basic operating principles, allowing you to
get the most out of your receiver.

GNSS Overview

Currently, the following three global navigation satellite systems
(GNSS) offer line-of-site radio navigation and positioning, velocity,
and time services on a global, all-weather scale to any user equipped
with a GNSS tracking receiver on or near the earth’s surface:

* GPS - the Global Positioning System maintained and operated by
the United States Department of Defense. For information on the
status of this system, visit the US Naval Observatory website or
the US Coast Guard website.
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* GLONASS - the Global Navigation Satellite System maintained
and operated by the Russian Federation Ministry of Defense. For
information on the status of this system, visit the Coordinational
Scientific Information Center website.

* GALILEO - an upcoming global positioning system maintained
and operated by Galileo Industries, a joint venture of several
European space agencies/companies working closely with the
European Space Agency. Unlike GPS and GLONASS, this is a
civil endeavor and is currently in the development and validation
stage. For information on the status of this system, visit the
Galileo Industries website.

Despite numerous technical differences in the implementation of
these systems, satellite positioning systems have three essential
components:

» Space — GPS, GLONASS, and GALILEO satellites orbit
approximately 12,000 nautical miles above earth and are
equipped with a clock and radio. These satellites broadcast
ranging signals and various digital information (ephemerides,
almanacs, time&frequency corrections, etc.).

* Control — Ground stations located around the earth that monitor
the satellites and upload data, including clock corrections and
new ephemerides (satellite positions as a function of time), to
ensure the satellites transmit data properly.

* User — The community and military that use GNSS receivers to
calculate positions.

Calculating Absolute Positions

When calculating an absolute position, a stationary or moving
receiver determines its three-dimensional position with respect to the
origin of an Earth-Center Earth-Fixed coordinate system. To calculate
this position, the receiver measures the distance (called pseudoranges)
between it and at least four satellites. The measured pseudoranges are
corrected for clock differences (receiver and satellites) and signal
propagation delays due to atmospheric effects. The positions of the
satellites are computed from the ephemeris data transmitted to the
receiver in navigation messages. When using a single satellite system,
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the minimum number of satellites needed to compute a position is
four. In a mixed satellite scenario (GPS, GLONASS, GALILEO), the
receiver must lock on to five or more satellites to account for the
different time scales used in these systems and to obtain an absolute
position.

Calculating Differential Positions

DGPS, or Differential GPS, is a relative positioning technique where
the measurements from two or more remote receivers are combined
and processed using sophisticated algorithms to calculate the
receivers’ relative coordinates with high accuracy.

DGPS accommodates various implementation techniques that can be
classified according to the following criteria:

* The type of GNSS measurements used, either code-phase
differential measurements or carrier-phase differential
measurements.

* If real-time or post-mission results are required, then real-time
applications can be further divided according to the source of
differential data and the communication link used.

With DGPS in its most traditional approach, one receiver is placed at
a known, surveyed location and is referred to as the reference receiver
or base station. Another receiver is placed at an unknown location and
is referred to as the remote receiver or rover receiver. The reference
station collects the code-phase and carrier-phase measurements from
each GNSS satellite in view.

* For real-time applications, these measurements and the reference
station coordinates are then built up to the industry standard
RTCM—or various proprietary standards established for
transmitting differential data—and broadcast to the remote
receiver(s) using a data communication link. The remote receiver
applies the transmitted measurement information to its observed
measurements of the same satellites.

* For post-mission applications, the simultaneous measurements
from reference and remote stations are normally recorded to the
receiver’s internal memory (not sent over communication link).
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Later, the data is downloaded to a computer, combined, and
processed.

Using this technique, the spatially correlated errors—such as
satellite orbital errors, ionospheric errors, and tropospheric
errors—can be significantly reduced, thus improving the position
solution accuracy.

A number of differential positioning implementations exist, including
post-processing surveying, real-time kinematic surveying, maritime
radio beacons, geostationary satellites (as with the OmniSTAR
service), and Satellite Based Augmentation Systems (WAAS,
EGNOS, MSAS).

The real-time kinematic (RTK) method is the most precise method of
real-time surveying. RTK requires at least two receivers collecting
navigation data and a communication data link between the receivers.
One of the receivers is usually at a known location (Base) and the
other is at an unknown location (Rover). The Base receiver collects
carrier phase measurements, generates RTK corrections, and sends
this data, along with the coordinates of the reference station, to the
Rover receiver. The Rover processes this transmitted data with its
own carrier phase observations to compute its relative position with
high accuracy, achieving an RTK accuracy of up to 1 cm horizontal
and 1.5 cm vertical.

Essential Components for Quality Surveying
Achieving quality position results requires the following elements:

* Accuracy — The accuracy of a position primarily depends upon
the satellite geometry (Geometric Dilution of Precision, or
GDOP) and the measurement (ranging) errors.

— Differential positioning (DGPS and RTK) strongly mitigates
atmospheric and orbital errors, and counteracts Selective
Auvailability (SA) signals the US Department of Defense
transmits with GPS signals.

— The more satellites in view, the stronger the signal, the lower
the DOP number, the higher the positioning accuracy.

P/N 7010-0935 1-5



Introduction

* Availability — The availability of satellites affects the calculation
of valid positions. The more visible satellites available, the more
valid and accurate the position. Natural and man-made objects
can block, interrupt and distort signals, lowering the number of
available satellites and adversely affecting signal reception.

* Integrity — Fault tolerance allows a position to have greater
integrity, increasing accuracy. Several factors combine to provide
fault tolerance, including:

— Five or more visible satellites for only GPS or only
GLONASS:; six or more satellites for mixed scenarios.

— Satellite Based Augmentation Systems (WAAS, EGNOS,
etc.) creates and transmit, along with DGPS corrections, data
integrity information (for example, satellite health warnings).

— Current ephemerides and almanacs.

Receiver Overview

The Net-G3A, with G3 tracking technology, represents the latest in
GNSS-capable technology. This receiver provides greater value by
virtue of its ability to keep up with changes in GNSS-signal
enhancements through simple firmware upgrades, protecting your
investment to the highest possible degree.

When power is turned on and the receiver self-test is completed, the
receiver’s 144 channels initialize and begin tracking visible satellites.
Each of the receiver’s channels can be used to track any one of the
GPS, GLONASS, or GALILEO signals. The number of channels
available allows the receiver to track all visible GNSS satellites at any
time and location.

An external GNSS antenna equipped with a low noise amplifier
(LNA) and the receiver’s radio frequency (RF) device are connected
with a coaxial cable. The wide-band signal received is down-
converted, filtered, digitized, and assigned to different channels. The
receiver processor controls the process of signal tracking.

Once the signal is locked in the channel, it is demodulated and
necessary signal parameters (carrier and code phases) are measured.
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Also, broadcast navigation data are retrieved from the navigation
frame.

After the receiver locks on to four or more satellites, its absolute
position in WGS-84 and the time offset between the receiver clock
and GPS time are computed. This information and the measurement
data can be stored in the optional Compact Flash card or the USB
mass storage device (UMS) and downloaded later onto a computer,
then processed using a post-processing software package. When the
receiver operates in RTK mode, raw data measurements can also be
recorded into the receiver’s Compact Flash memory or a UMS. This
allows the operator to double check real-time results obtained in the
field.

The Net-G3A offers a unique collection of features and capabilities in
a single design. They include:

* 144 universal tracking channels
* Multipath reduction

* Adjustable phase locked loop (PLL) and delay lock loop (DLL)
parameters

* Anti-jamming suppressor

* 1PPS and event marker

» External oscillator input

* GNSS-disciplined internal crystal oscillator output
* RS232C and USB port connectivity

» USB storage device

* Removable memory

* Backup battery system

 Ethernet connectivity

* Web-based management

* Satellite Based Augmentation Systems (WAAS, EGNOS, etc.)

* Dual- or multi-frequency modes, including static, kinematic, real-
time kinematic (RTK), and differential (DGPS) survey modes.
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* Ntrip server/client and MAC functionality

» Multiple survey parameters, including multiple mask angles,
static and dynamic modes, auto data logging, etc.

Getting Acquainted

The standard hardware configuration of the Net-G3A includes:

* a 144-channel GNSS * an external GPS antenna port

receiver * a frequency input/output port

a 1PPS port and Event
* a USB device and USB host Marker port
ports

* four serial data ports

¢ two internal batteries (for 25
* an Ethernet port hours of emergency

e an interface for controlling operation)

and viewing data logging, * two power ports
link, and power status

¢ a CF card slot

Although this is the standard configuration, the OAF must enable
some of these features for proper operation. See “Option
Authorization File (OAF)” on page 1-21 for details.

The standard Net-G3A kit includes the Net-G3A, a set of cables,
power supply, Topcon GPS+ software CD, Compact Flash card, and
documentation.

Net-G3A Receiver

The Net-G3A receiver’s advanced and feature packed design provides
greater versatility, reliability, and efficiency to implement a
cost-effective and productive network infrastructure in a timely
manner. Managed with the GNSS Receiver Interface Language
(GRIL) and equipped with various hardware interfaces, this receiver
offers unchallenged flexibility:
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* Flexibility in software applications that control and monitor the
receiver’s behavior, including PC-CDU, TRU, and TopNET, as
well as user-written applications.

* Flexibility in the physical interface used to connect the receiver
with various external devices, including computers, network
devices, various sensors, frequency sources, etc.

MINTER

The MINTER is the receiver’s minimum interface used to display and
control data input and output (Figure 1-2 on page 1-10).

The STAT LED displays the status of tracked satellites.
» Red blink — receiver is on, but no satellites are being tracked.

* Green blink — receiver is on and tracking satellites; one blink per
tracked GPS satellite.

* Orange blink — receiver is on and tracking satellites; one blink per
tracked GLONASS satellite.

The LINK LED displays Ethernet connection status.

¢ Solid Green — A valid Ethernet connection with an active device
on the network is established.

¢ Off — No Ethernet connection is established.
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STAT LED LINKLED Power LEDs Function Button

\ \ /( I/ POV}er Button

/_ T

REC LED RX/TX LED
Figure 1-2. Net-G3A MINTER

The PWR LEDs display the status of power supplied from the
corresponding external or internal power source.

* Solid Green — The receiver accepts power from an external power
source connected to the corresponding PWR port. This power is
within an allowed operating voltage range (6-28 V DC).

The corresponding backup battery is fully charged.

* Solid Yellow — The receiver accepts power from an external
power source connected to the corresponding PWR port, and this
power is within an allowed operating voltage range (6—28 V DC),
but is not being used to power the receiver.

* Solid Red — A power failure has occurred (with the connected
power source) or power is not supplied to the corresponding PWR
port. For details, see “Powering Problems” on page 5-2.

* Green blinks plus red blinks — The receiver accepts power from
an external power source connected to the corresponding PWR
port and is charging the corresponding battery.
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» Red blinks — The receiver is charging the corresponding battery.

* Off — The receiver consumes power from internal backup
batteries or the receiver is turned off.

The REC LED displays the data recording status. See “The FN
button” on page 1-11 for more information on REC LED behavior
when using the function button.

» Green blinks — Each blink indicates that data is being written to
the CF card.

* Solid Orange — This indicates the receiver is changing modes.

* Orange blinks — This indicates that the receiver is checking its
internal file system (after clearing the NVRAM or loading new
firmware). During this operation, the file system is not accessible
for CDU (control display unit) applications or for data recording.
This operation may require from fractions of a second to several
minutes, depending on the circumstances and the amount of
memory on the CF card. If the LED blinks orange every second,
this also indicates that raw data is being transferred to a UMS
device.

¢ Solid Red — This indicates a fault condition with the receiver
(memory full, no CF card installed, a hardware problem, or an
improper OAF).

Table 1-1 on page 1-12 describes the REC LED status when using the
FN button.

The RX TX LED displays the status of the internal radio modem. In
the current version, the LED is off and is retained for future updates.

The power button turns the receiver on and off.

The FN button switches the receiver between information modes and
post-processing modes, starts/stops data recording, and changes the
baud rate of the serial port to 9600. See “MINTER Operation” on
page 3-16 for more information.
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Table 1-1 describes the REC LED status when using the FN button.

Table 1-1. FN Button Operations and REC LED Status

FN Key

REC LED

Status

When data recording is off, and the FN key is...

No light No data recording.

Orange blink | Internal file system test in progress.
Not pressed

Red No free memory; hardware problem with

data recording; no CF card.

If FN key mode is “LED blink mode switch”

Orange Release to change information mode.
Pressed for < 1
second If FN key mode is “Occupation mode switch”

Orange No function.

If FN key mode is “LED blink mode switch”

Green Release to start data recording (post-
Pressed for 1-5 processing occupation mode undefined).
seconds

If FN key mode is “Occupation mode switch”

Green Release to start recording (Kinematic or

Static post-processing occupation mode).

Pressed for 5-8 Red Release to turn serial port A baud rate to
seconds 9600 bps.
Pressed for > 8 No light No function.

seconds
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Table 1-1. FN Button Operations and REC LED Status (Continued)

FN Key

REC LED

Status

When data recording is on, and the FN key is...

Red No free memory; hardware problem with
data recording.
If FN key mode is “LED blink mode switch”
Green Data recording started (post-processing
occupation mode undefined).
Not pressed If FN key mode is Occupation mode switch
Green Data recording started (Kinematic post-
processing occupation mode).
Orange Data recording started (Static post-
processing occupation mode).
If FN key mode is “LED blink mode switch”
Orange Release to change information mode.
Pressed for < 1
second If FN key mode is “Occupation mode switch”
Orange Release to toggle between Static and
Kinematic post-processing modes.
Pressed for 1-5 No light Release to stop data recording.
seconds
Pressed for 5-8 Red Release to turn serial port A baud rate to
seconds 9600 bps.
Pressed for > 8 No light No function (data recording still on).

seconds
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Data and Power Ports

The Net-G3A has ports on both the front and back panels.
The front panel has one port (Figure 1-3): Serial (7 pin ODU-MINI-

SNAP) — used for communication between the receiver and an
external device. This is the receiver’s serial port A.

Serial Port

Figure 1-3. Net-G3A Front Panel Ports

The back panel has the following 10 ports (Figure 1-5 on
page 1-16):
* Serial ports (9 pin D-shell connector) — used for communication
between the receiver and an external device.
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* Ethernet/USB port (12-pin ODU-MINI-SNAP) — used to connect
the receiver to a computer or network via the adapter cable, which
is also connected to the Ethernet/USB port.

Connectstothe
Ethernet/USB
port on the
receiver

Ethernet and
USB ports

Figure 1-4. Adapter Cable

* 1 PPS port (BNC connector) — used for generating one pulse per
second signals with programmable reference time, period, and
offset. The pulse is synchronized to a specified reference time.

» Event Marker port (BNC connector) — used to input an event
synchronized with a specified time reference.

* GPS Antenna port (Type N connector) — used for detecting GNSS
signals.

 External Frequency port (BNC connector) — used for an external
frequency input or the receiver’s internal frequency output.

* Power ports (5 pin ODU-MINI-SNAP) — used to connect the
receiver to an external power source.

* USB (Mini-B) — used for high-speed data transfer and
communication between the receiver and an external device. This
port is located on the adapter cable, which is connected to the
Ethernet/USB port.

* USB (Type A) — used to transfer raw data files from the receiver’s
CF card to the connected USB mass storage device (UMS). This
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port is located on the adapter cable, which is connected to the
Ethernet/USB port.

Antenna 1 PPS Serial  Power

/_\\
(®)
ANTENNA

7\ SERIAL C
(®)
G e()o

\_
\ \ \ \\/

External Frequency Event Serial  Ethernet/USB

 —

Figure 1-5. Net-G3A Back Panel Ports

CF Card Siot

The CF (Compact Flash) card slot resides on the front panel under the
door (Figure 1-6 on page 1-17) and connects an optional CF card to
the receiver board to provide memory. A Compact Flash card can be
purchased at your local computer supply store. See “CF Cards
Compatible with the Net-G3A” on page A-15 for a list of compact
flash cards successfully tested with the Net-G3A. Before using any
other CF cards, consult with Topcon customer support about
compatibility. See “Obtaining Customer Support” on page 5-7.

The receiver recognizes up to 2 GB of memory. The recognizable
capacity is controlled through the corresponding receiver option.

Once installed, the CF card usually remains inside the receiver. The
data that resides on the CF card can be accessed via the serial, USB,
or Ethernet port.

To preserve data integrity, only install or remove the CF card when
the receiver is powered off.
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Always initialize the file system on the installed CF card before the
first use. The initialization procedure is described in “Initializing File
System” on page 4-12.

y 4
Card Slot Button 7'\, /J
CF Card Slot

Figure 1-6. Net-G3A CF Card Slot
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Mounting Holes

The receiver has four mounting holes on the bottom to install #8-32
screws for a permanent mount (Figure 1-7). Installing the receiver
using these screws prevents unwanted movement.

I

Figure 1-7. Net-G3A Bottom Mounting Holes

Cables and Power Supply

The Net-G3A package includes standard communication and power
cables for configuring the receiver and providing a power source to
the receiver. Table 1-2 lists these cables.

Table 1-2. Net-G3A Package Cables

Cable Description Cable lllustration

USB Cable

Connects the receiver to an external
device (controller or computer) for
high-speed data transfer and receiver
configuration.

p/n 14-008081-01

This can also be purchased at any
local computer store.
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Table 1-2. Net-G3A Package Cables (Continued)

Cable Description

Cable lllustration

Serial Cable

Connects the receiver to an external
device (controller or computer) for
data transfer and receiver
configuration. Body of connector is
black.

p/n 14-008005-03

Adapter Cable (with Ethernet
and USB ports)

Connects the receiver to a cross-over
or straight-through Ethernet cable for
networking.

p/n 14-008180-01LF

1PPS, Event Marker, External
Frequency In/Out Cable
Connects the receiver’s 1PPS,
EVENT, or EXT FREQ connector
with the corresponding connector on
an external device.

p/n 14-008010-01LF

Null Modem Cable

Connects the receiver with an external
device (controller or computer) for
data transfer and receiver
configuration.

p/n 14-008086-01

Can also be purchased at any local
computer store.

Power Cable

Connects the power supply unit to a
grounded outlet.

U.S. p/n 14-008052-01

Europe p/n 14-008054-01
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Table 1-2. Net-G3A Package Cables (Continued)

Cable Description

Cable lllustration

Power Supply Unit

Converts the alternating current (AC)
supplied from an electrical outlet to a
direct current (DC) for powering the
receiver.

The unit connects to the receiver via
the receiver power cable (see the
power related sections in Chapter 2).
p/n 22-034101-01

Receiver Power Cable

Connects the receiver and the power
supply unit via SAE connectors. Body
of connector is red.

p/n 14-008016-04LF

@

L2

%

Fused Pigtail Cable

Connects the receiver power cable via
SAE connectors with a custom power
supply unit via bare wires.

p/n 14-008099-01

Other Kit Accessories

The standard accessories in the Net-G3A package includes a 512 MB
CF memory card, a CD that contains standard Topcon GPS+
configuration software, a fuse, and receiver documentation.

Figure 1-8. Net-G3A Included Accessories

For more details on the optional accessories and packages available
for the Net-G3A, contact your local Topcon dealer.
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Option Authorization File (OAF)

Topcon Positioning Systems issues an Option Authorization File
(OAF) to enable the specific options that customers purchase. An
Option Authorization File allows customers to customize and
configure the receiver according to particular needs, thus only
purchasing those options needed.

Typically, all receivers ship with a temporary OAF that allows it to be
used for a predetermined period of time. When the receiver is
purchased, a new OAF permanently activates desired, purchased
options. Receiver options remain intact when clearing the NVRAM or
resetting the receiver.

The OAF enables the following kinds of functions. For a complete list
of available options and details, visit the TPS website at
www.topconpositioning.com or consult your TPS dealer.

* Type of signal (standard L.1; optional L2, L5 GPS, GLONASS,
GALILEO)

» External CF memory card

» Update rate standard 1Hz (optional 5, 10, or 50 or 100Hz)
e RTK at 1Hz, 5Hz, 10Hz, 20Hz, and 50 or 100Hz

¢ RTCM/CMR Input/Output

* 1PPS

* Event Marker

* Frequency Input/Output

* Anti-jamming

* Ethernet

* FTP

* Advanced multipath reduction

 Satellite Based Augmentation System (WAAS, EGNOS, MSAS)
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Notes:
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Successful deployment and operation of a Reference Station system
with the Net-G3A receiver requires careful site planning, feasibility
studies, and proper equipment configuration. These factors are critical
to maximize the performance of the Net-G3A and to seamlessly
integrate the receiver into an existing network or in establishing a new
network.

Once a location for the Net-G3A has been determined, you can begin
installing the hardware and software required to configure and
maintain the Net-G3A. After determining the application, use the
selected software to configure the receiver for your application.
Finally, collect almanacs and ephemerides to begin working with the
Net-G3A in its intended application. The following sections describe
these steps in detail:

* “Determining the Reference Station Site” on page 2-2

* “Installing Topcon Software” on page 2-5

* “Installing the CF Card” on page 2-8

* “Installing the USB Mass Storage Device (UMS)” on page 2-9
* “Powering the Receiver” on page 2-11

* “Charging the Backup Batteries” on page 2-13

* “Collecting Almanacs and Ephemerides” on page 2-14

* “Connecting the Receiver and a Computer” on page 2-15

* “Power Management” on page 2-24
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Determining the Reference
Station Site

The site at which the reference station will be installed requires that
the project team make in advance specific decisions about the goals of
the project and therefore the application. Once the application has
been decided and the goals clarified, a site inspection will help
determine specific hardware/software setups and other requirements.

For more details on site planning, refer to the UNAVCO website
(http://facility.unavco.org/) and the National Geodetic Survey (USA)
CORS website (www.ngs.noaa.gov/CORS/

Establish_Operate_ CORS.html), specifically the document titled
Guidelines for New and Existing Continuously Operating Reference
Stations (CORS).

Consider the Net-G3A Reference
Station Application

Several decisions about the reference station application need to be
determined before considering both the physical location and the
receiver setup. These decisions affect virtually all the associated
project planning, site inspection, hardware/software setup, and data
gathering activities. Among the questions to consider are the
following:

* who the end-user will be and how many there will be (those
accessing the data, those analyzing the data, etc.)

» what kinds of communication links will be used
» what kind of data are required and data formats

» where the receiver needs to be placed (based on available sites
and intended application)

* how the receiver will be used: as a single reference station or as
part of a network

* how long the project will last: a short-term or a long-term project
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All project team members should have a clear understanding of the
project’s purpose, goals, and application. Once the goals of the
application have been identified, preliminary sites can be chosen, and
then narrowed down to the most appropriate site.

Perform a Site Inspection for the
Net-G3A Reference Station

When determining the location in which to place the Net-G3A,
consider the relative safety of the physical location for both the
receiver and personnel. Successful installation and operation of the
reference station should meet the following guidelines:

¢ Location of the site and the receiver

The building site should have a clear view of the sky with no
reflective objects or surfaces in the vicinity.

The location of the receiver Receiver should be indoors,
placed on a flat surface (such as a table or stable shelf),
provide free access to the receiver’s front and rear panels, and
be easy to reach and handle for maintenance activities.

» Equipment connectivity and antenna cabling system

The site should provide appropriate routings for connecting
the various equipment. Cables should be unobtrusive, but
easy to maintain.

For proper equipment connectivity and functionality, use only
original and dedicated cables. Consider the following
recommendations when connecting your devices:

— Label each cable.
On all cable ends, securely attach a sticker with a cable
identifier.

— Do not exceed standard cable lengths.
The cable length should not exceed the maximum
distance specified in appropriate standards for the cable
being used.

— Keep all cable connectors free of dust, dirt, and
contaminants.
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— If you make your own cables, make sure that the cables
are properly crimped.

— Verify that you have connected each cable to its mating
connector, and it is firmly seated.

Building an antenna cabling system is one of the key
components to successful operation of the Reference
Station—especially when using an antenna cable longer than
30 meters or connecting multiple antennas to the same
receiver. For guidelines on building a cabling system, see
“Building an Antenna Cabling System” on page 3-20.

* Power accessibility

The site should provide and meet power specifications for the
receiver and other installed equipment. The receiver should
have direct access to a grounded outlet.

The Net-G3A is designed to accept two external power inputs
and automatically switch during power fluctuations to keep
the receiver operational.

—PWR 1 can be connected to the main power using the
Universal Power Supply included with the Net-G3A.

— PWR 2 can be connected to any alternative power source
capable of supplying 6 to 28 V DC (including an
Uninterrupted Power Supply).

If the main power fails, then the unit automatically switches
from PWR 1 to PWR 2. When power is restored on PWR 1,
the Net-G3A reverts to PWR 1, maintaining continuous
operation throughout the power interruption.

If both power inputs fail to deliver power to the receiver, then
the intelligent Battery-based Energy STorage (iBEST) system
will maintain continuous emergency operation. This system
provides you with ample time (up to 25 hours) to save
valuable data, isolate the problem, and restore the normal
operation without an interruption in the service. When the
normal operation is restored, the iBEST system automatically
transfers the load to an external power source and maintains
the backup batteries in a charged condition.

* Temperature and humidity control
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The Net-G3A is designed to withstand harsh field
environments and can be used as a temporary or semi-
permanent Reference Station, as needed. For permanent
installations, install the Net-G3A in a more protected and
controlled environment.

* Protection against lightning and other power surges

To protect against sudden surges in electricity, installing
lightning finials, surge protectors, etc. will help shield
electronic equipment from direct or indirect lightning strikes.
Consult a certified electrician for recommendations and
installation.

Installing Topcon Software

The Topcon GPS+ CD includes the following software programs used
for configuring and maintaining the receiver. This software is also
available on the Topcon website (www.topconpositioning.com) to
registered users.

e PC-CDU e FlLoader
ver. 7.12 or newer ver 1.0.07 or newer

* Topcon Link
ver 7.2 or newer

If you are installing the program(s) from the GPS+ CD, insert the CD
into the computer’s CD-ROM drive. If you are downloading the
program(s) from the website, then extract the program’s files into a
folder on the computer’s hard drive. Refer to the Topcon Link
documentation for details on installation and usage.

If you purchased the TopNET reference station software suite, then
refer to the corresponding documentation for installing and using this
software and for configuring the Net-G3A using TopNET.
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Installing PC-CDU

PC-CDU™ is a comprehensive Windows® software product
designed for controlling GPS+ receivers developed by Topcon
Positioning Systems. PC-CDU uses the GNSS Receiver Interface
Language (GRIL) to configure various receiver settings and diagnose
receiver performance. PC-CDU is available for free on the Topcon
website (Www.topconpositioning.com) or the GPS+ CD.

Computer requirements for PC-CDU are: Windows® 98 or newer and
an RS-232C or USB port. Use PC-CDU version 7.12 or newer to
correctly configure the receiver.

@ Refer to the PC-CDU Reference Manual for full
details on installing and using PC-CDU.

1. Create a PC-CDU folder on your computer’s hard drive, and
place the compressed PC-CDU zip file (retrieved from either the
Topcon website or the GPS+ CD) in this folder.

2. Navigate to the PC-CDU folder, and double-click the PC-CDU
zip file.

3. Extract the PCCDU.EXE and associated *.dll file to the PC-CDU
folder (Figure 2-1).

4. Create a shortcut on the computer’s desktop for quick access to
PC-CDU (Figure 2-1).

File Edit View Favorites Tools  Help
Q@ek - (0 (T O seanch | [ poders | [T
Address 23 Cihtopeonipeedu ¥ B
Fulders x Hame Size  Type Date Modified
B pesktop | Hpccou ms.zie 854 KB WinZip File 1/5(2004 456 FM #
® [5) My Documents [ELPTACCES. WD 6KE Virtual devic...  6/1/2000 6:39 PM
= } My Computer ﬁ,PCCDLI‘EXE 2,224 KB Application 12§23/2003 5:16 FM E‘tnu
® L 3% Floppy (A2
= S Mew Yalume (C:)
# |5 Documents and Settings
# () Program Files
19 quarantine
1) TEMP
= 3 topean
3 predu
13 unzipped
F 1) WINDOWS
& Lk CD Drive (D2)
® b CD Drive (E) )
E >

Figure 2-1. Extract Program and Create Shortcut
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To uninstall PC-CDU, navigate to the location of the *.exe file.
Select the file, and press Delete.

Installing FLoader

FLoader is a firmware loading program for the GPS board inside the
receiver. FLoader is available for free on the TPS website
(www.topconpositioning.com) or the GPS+ CD.

Computer requirements for FLoader are: Windows® 98 or newer and
an RS-232C port. Use FLoader version 1.0.07 or newer to correctly
configure the receiver.

1. Create an FLoader folder on your computer’s hard drive, and
place the compressed FLoader zip file (retrieved from either the
website or the GPS+ CD) in this folder.

2. Navigate to the FLoader folder, and double-click the FLoader
zip file.

3. Extract the FLoader.exe file to the FLoader folder (Figure 2-2).

Create a shortcut on the computer’s desktop for quick access to
FLoader (Figure 2-2).

& floader Q@E|
Fle Edt View Favortes Tools Help o
Qe - @ F O sac |[2 roers | [T
address |2 Critopeonifioader v B
Folders X Hame Siee | Type Date Modifisd
(@ Deskiop a “lffinader app.zip : 234KE  WinZip File 8/17/2005 2:17 PM #
S — & Flosder.=xe 524KE  Applcation 2/12/2002 5:43 FM IE‘ FL
= 4 My Computer
& Jd 3% Floppy (A1) IFILEEEE?
B < New Walume (C:)
# () Documents and Settings
# |2 Program Files
13 quarantine
I TEMP
= (£ topeon
3 bteonf
(3 floader
2 peedu
3 unzipped
# () WINDOWS v
< 3 & >

Figure 2-2. Extract Program and Create Shortcut

To uninstall FLoader, navigate to the location of the *.exe file.
Select the file, and press Delete.
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Installing the CF Card

Behind the door of the front panel is a slot for the optional CF card.
The CF card provides memory space in which to save logged data.
The Net-G3A package includes a 512MB CF card or an optional 2GB
CF card. A CF card can also be purchased at your local computer
supply store.

Make sure to install the CF card prior to operating the Net-G3A. The
door also provides quick access to the card for removal.

To preserve data integrity, only install or remove the
CF card when the receiver is powered off.

1. Ensure the receiver is turned off.
Turn the two door screws to the left to open the door.

3. Carefully insert the CF card, label side up, into the CF card slot
(Figure 2-3 on page 2-8).

Eject Button

Figure 2-3. Install the CF Card
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Ensure the button is recessed before closing the
receiver door.

Once the receiver is turned on, the receiver board detects the CF card
and is ready for use as needed.

Always initialize the file system on the installed CF

@ card before the first use. The initialization
procedure is described on “Initializing File System”
on page 4-12.

To remove the CF card, first turn off the receiver. Open the receiver
door, and press the small button to the left of the card slot. The CF
card pops out.

Installing the USB Mass
Storage Device (UMS)

Connect the adapter cable to the Ethernet/USB port on the rear panel.
This adapter cable is equipped with a type A USB port for the
optional UMS device. The UMS provides a sleek and high-capacity
storage solution for transferring raw data files from the receiver’s CF
card. The Net-G3A supports flash-based UMS devices as well as hard
drive-based UMS devices with USB 1.1/2.0 interface. A UMS device
can be purchased at your local computer supply store.

Before using the UMS device, it should be formatted to a FAT32 file
system, properly connected to the NET-G3A receiver, and activated.
For more details, see “Formatting the UMS Device” on page 2-10 and
“Connecting and Activating the UMS Device” on page 2-10.
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Formatting the UMS Device

The NET-G3A requires an external UMS device formatted for the
FAT32 file system. The UMS device can be formatted using the
internal Disk Management application provided by Microsoft
Windows; however, this application cannot create partitions larger
than 32 GB. For more information about FAT32 limitations and how
to format the UMS device to the FAT32 file system using the Disk
Management application, refer to Microsoft® Help and Support at
www.support.microsoft.com. If you want more than 32 GB of disk
space on the UMS device, then use external disk-partition software.

Formatting the UMS device permanently erases all
@ data on the device. Back up any data that you want
to keep before formatting the device.

Connecting and Activating the UMS
Device

1. Connect the adapter cable to the Ethernet/USB port on the rear
panel of the Net-G3A receiver.

Figure 2-4. Connecting the UMS Device

2. Connect the UMS device to the type A USB port on the adapter
cable. (See Figure 2-4). The receiver does not have to be turned
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on. If the receiver is turned on, then the receiver board begins to
detect the UMS device and the REC LED blinks yellow.

3. If necessary, supply power to the UMS device:

* For a flash-based UMS device, the NET-G3A supplies enough
power through the USB connection that an external power supply
for the UMS device is not necessary.

* For a hard drive-based UMS device, it is recommended to power
it through an external AC power adapter available with the
device.

4. To start using the UMS device, it should be activated. For
information about the activation procedure, see “Downloading
Data Files to a UMS Device” on page 4-4.

To remove the UMS device, Carefully take out the UMS device
from the USB port.

To preserve data integrity, only install or remove the
@ UMS device when the receiver’s REC LED does
not blink orange.

Powering the Receiver

The Net-G3A receiver is designed to derive power from external
power sources (Figure 2-5 on page 2-12) or its backup batteries
(iBEST). When setting up the receiver, consider the following
powering requirements:

* Never use an extension cord for permanent power supply. This
kind of setup can create a fire hazard.

* Always use a grounded outlet.

» Use a surge protector to protect connected electronics devices.
The Net-G3A has two power ports and either port powers the receiver.
To power on the Net-G3A:

1. Connect the power cable to the power supply unit.
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2. Connect the SAE connectors on the power adapter cable and
power supply unit.

3. Connect the power adapter cable to a PWR port on the receiver’s
rear panel.

4. Plug the power supply to an available outlet.

=
To grounded
outlet

Figure 2-5. Connecting the Net-G3 to a Power Source

Checking Power Status

You can check the receiver’s power status using the PWR LEDs or
available Topcon software. The power LEDs on the receiver indicate
the following power status:

* Solid Green — power within the acceptable range (6-28 V DC) is
present on this PWR port and is being used to power the receiver.
The corresponding backup battery is fully charged.

* Solid Yellow — power within the acceptable range (6—28 V DC) is

present on this PWR port but is not being used to power the
receiver.

* Solid Red — either a power failure has occurred (with connected
power source) or power is not present on this PWR port. For
details, see “Powering Problems” on page 5-2.
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* Green blinks — power within the acceptable range (6-28 V DC) is
present on this PWR port and is being used to power the receiver
and to charge the corresponding battery.

* Red blinks — the corresponding backup battery is being charged.

* Off — the receiver consumes power from internal backup batteries
or the receiver is turned off.

Refer to the corresponding software manual for details on checking
the power status via installed software.

Turning On/Off the Receiver

To turn on the receiver, press and hold the power button until the
LEDs briefly flash.

To turn off the receiver, press and hold the power key for more than
one and less than four seconds (until both the STAT and the REC
LEDs are off). This delay (about 1 second) prevents the receiver from
being turned off by mistake.

Charging the Backup Batteries

The charging circuitry of the iBEST system automatically charges the
backup batteries whenever the Net-G3A is plugged into an external
power source via any PWR connector. The receiver has to be on to
charge the batteries.

The iBEST system charges the backup batteries
@ when the input voltage is between +12 and +16
Vdc.

An approximately 8-hour charge cycle fully charges the batteries; the
batteries charge simultaneously. The batteries cannot be overcharged.

When fully charged, the iBEST system provides up to 25 hours of
emergency operation (approximate, at room temperature). If the
iBEST system detects the return of normal external voltages at any
time during emergency operation, then the system automatically uses

P/N 7010-0935 2-13



Pre-setup Preparation

the power supplied by the external source and maintains the backup
batteries in a charged condition.

The Li-Ion batteries used in the iBEST system should run at no less
than 80 percent capacity after 500 charging cycles. These batteries do
not need to be drained before recharging.

Collecting Almanacs and
Ephemerides

Each satellite broadcasts a navigation message that includes the
ephemeris parameters of the satellite, the almanac, and various other
information. The ephemeris parameters describe the orbital motion of
the satellite and are used to predict its location/trajectory. The
almanac gives the approximate orbit (course) for the transmitting
satellite and all other satellites in the same system only.

* GPS and GLONASS satellites broadcast ephemeris data
cyclically within 30 seconds.

» GPS satellites broadcast almanac data cyclically within 12.5
minutes; GLONASS satellites broadcast almanac data cyclically
within 2.5 minutes.

When the receiver has an almanac, you can considerably reduce the
time needed to search for and lock onto satellite signals.

The receiver regularly updates the almanac and ephemerides and
stores the most recent versions in its Non-Volatile Random Access
Memory (NVRAM).

You need to collect or update the almanac and ephemerides under the
following circumstances:

* If the receiver has been off for a long time.

If the last known receiver position, stored in the NVRAM, is
different from the present position by several hundred kilometers.

* After loading a new OAF.
After loading new firmware.
* After clearing the NVRAM.
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To collect almanacs and ephemerides:

1. Set up the receiver.
The external antenna should be in a location with a clear view of
the sky.

Turn on the receiver.

3. Wait for about 15 minutes while the receiver collects complete
almanac and ephemeris data from the satellites.

lock onto satellites, then clear the NVRAM. See

@ If 15 minutes have passed and the receiver does not
“Clearing the NVRAM” on page 4-18 for details.

Connecting the Receiver and a
Computer

Once you have established a connection between the receiver and the
computer, you can configure the receiver and its components, send
commands to the receiver, and download files from the receiver’s
memory. To do this, use the installed software PC-CDU or use
TopNET, etc. Both PC-CDU and TopNET provide an interface for
various configuration, monitoring, and management functions for the
receiver. Other software, such as FLoader, are used to update,
maintain, or configure the components of a connected receiver.

The Net-G3A uses the following types of cables to connect with a
computer:
* RS232 cable (See “Establishing an RS232 Cable Connection” on
page 2-16.)
* USB cable — the TPS USB driver must be installed on the
computer (See “Establishing a USB Cable Connection” on
page 2-17.)
 Ethernet cable — the computer must have a network card and be
configured with the TCP/IP protocol (See “Establishing an
Ethernet Connection” on page 2-17.)
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Establishing an RS232 Cable
Connection

The following steps describe the physical connection of the cable,
receiver, and computer. For a description of a software connection
with the receiver, see “PC-CDU Connection Parameters” on page 2-
22,

1. Using the RS232 cable, connect the serial port of your computer
(usually COM1) to the receiver’s serial port (either ODU or
DE-9). Use the serial port most convenient for you because both
are equal in functionality but simply require different cables.

Figure 2-6. Net-G3A Serial Ports

2. Press the power buttons on the receiver and computer to turn
them on.
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Establishing a USB Cable Connection

Make sure the computer has the TPS USB driver installed. The
following steps describe the physical connection of the cable,
receiver, and computer. “PC-CDU Connection Parameters” on
page 2-22 describes a software connection with the receiver.

1. Using the USB cable, connect the USB port of your computer to
the receiver’s Ethernet/USB port located on the rear panel via the
adapter cable.

Adapter
Cable

Ethernet/USB
Connector

USB Ports

USB Cable

Figure 2-7. Net-G3A USB Ports

2. Press the power buttons on the receiver and computer to turn
them on.

Establishing an Ethernet Connection

Make sure the IP settings of the receiver have been configured before
connecting the receiver and computer using an Ethernet connection.
This configuration requires connecting the receiver and computer
using an RS232 cable before connecting them with an Ethernet cable.
See “Configuring an Ethernet Connection Using PC-CDU” on

page 2-19 for details.
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The Net-G3A and associated software have two Ethernet connection
options using the Ethernet adapter from the Net-G3A kit and an
Ethernet cable purchased from a computer supply store:

* a direct connection — requires an Ethernet crossover cable

* an existing TCP/IP Ethernet network connection — requires an
Ethernet straight-through cable

The following steps describe the physical connection of the cables,
receiver, and computer. “PC-CDU Connection Parameters” on
page 2-22 describes a software connection with the receiver.

1. Insert the 12-pin connector of the Ethernet adapter into the
receiver’s ETHR port.

2. Connect the other end of this adapter to either end of the Ethernet
crossover or straight-through cable.

3. Plug the second end of the Ethernet cable into the Ethernet jack
on the back of the computer or into a network hub or switch.

Straight-through Cable
to Network Hub

\%f Crossover Cable

to Computer

Figure 2-8. Connect Ethernet Cable
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Configuring an Ethernet Connection
Using PC-CDU

Before you can use the Ethernet option on a Net-G3A, the settings for
this connection method need to be configured. You will need the
following hardware/software components to use an Ethernet
connection.

* A computer with an Ethernet card installed and the TCP/IP
protocol configured.

¢ The latest version of PC-CDU.

* A Net-G3A receiver with an installed Ethernet port and the
Ethernet port option enabled. For network connections, enable
the FTP connections option. See “Managing Receiver Options”
on page 4-14 for checking receiver options.

* A network connection requires a unique static IP address whether
or not a Dynamic Host Configuration Protocol (DHCP) is used on
the network, a subnet mask, and a default gateway for each
receiver.

closely with the system administrator to ensure a

@ When connecting TPS receivers to a network, work
successful connection.

The following procedure describes how to connect the receiver to a
computer using Ethernet ports and how to configure the receiver to be
recognized in a network. The example in this procedure uses a
protocol with the following settings:

e JP address — 192.168.0.1

* Gateway — 192.168.0.3 (For a direct connection: If two devices
are directly connected and have no connections to another
network, then the gateway address can be set to all zeros.)

¢ Subnet mask — 255.255.255.0
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Both Ethernet connection methods are included in the following
procedure.

< Use a direct Ethernet connection to test the
effectiveness of this connection method before

connecting to a network.

1. Connect the receiver and computer using an RS232 cable. See
“Establishing an RS232 Cable Connection” on page 2-16 for
details.

2. Start PC-CDU, and select the following connection parameters.
Click Connect.

* Connection Mode — Direct
 Port — the serial port connecting the computer and receiver

* Baud rate — the communication rate between the computer
and receiver (usually 115200)

3. Click Configuration » Receiver » Ports » Ethernet.
Select the following IP Settings for the receiver (Figure 2-9 on
page 2-21):
* [P Address — enter the same value as the computer’s IP
address, but increment the last number by one. The last

number must differ from the computer's I[P address but be
within the 0 to 255 range (for example, 192.168.0.2).

* [P Mask — enter the same number used for the computer.
» Gateway — enter the same number used for the computer.

5. In the Telnet Settings area, leave all settings at the defaults, but
ensure that TCP port is set to 8002 (Figure 2-9 on page 2-21).

* TCP port — 8002 (default value). This is the port on which the
receiver listens for telnet-like connections. The receiver
allows up to five simultaneous telnet-like connections.

* Timeout — 600 (default value). This parameter sets the
amount of time in seconds the receiver allows an inactive

connection to remain open. After this time, the receiver
terminates the unused connection.
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6. For network connections, configure FTP Settings (optional) with
the following selections (Figure 2-9):

* TCP port — 21 (default value). This is the port on which the
receiver listens for an FTP connection. The receiver allows up
to five FTP connections at a time.

* Timeout — 600 (default value). This parameter sets the length
of time in seconds the receiver allows an inactive connection
to remain open. After this time, the receiver terminates the
unused connection.

7. If required, enter a Network Password to access the FTP server
(Figure 2-9).

Eﬂ Receiver Configuration x|

Generall MINTEHI Positioningl Base I Fiover Eventsl Advancedl

Serial | Paralll| Madem | USE  Ethemet | 1ep |

‘ ‘warning. Mewly applied settings will be activated only after receiver reset.

IP Settings—————————— Telnet Settings FTP Setting:
IP &ddress: |1 9216802 TCF Part: ISDD2 TCF Part: |21
IP Mask: |255.255.255.U Timeout [g]: [500 Timeout [g]: [500

Gateway:  |192168.03

Metwork Password: I

Fiefrezh Lpply

ak, I Exit | Save | SetallparameterstodefaultsI

Figure 2-9. Ethernet Connection Settings — FTP Network Example

8. Click Apply, and then OK to set the parameters.
9. Click Tools » Reset receiver to restart the receiver.
10. Click File » Disconnect.

11. Connect the receiver and computer or a networking device (hub,
switch, etc) as described in “Establishing an Ethernet
Connection” on page 2-17.
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PC-CDU Connection Parameters

When connecting to the receiver via PC-CDU, the type of connection
determines the parameters to select. Table 2-1 and Table 2-2 list the
parameters for the four connection types.

Table 2-1. PC-CDU Connection Parameters for RS232 and USB

Parameter RS232 USB
Connection Direct
Mode
Port Port connecting the computer | USB
and receiver (typically COM1,
COM2 for RS232)
Baud Rate Communication rate between n/a

the receiver and the computer
(usually 115200)

Rec ID n/a Receiver’s identification
number
RS232
]
Caonnection made
’7(-' Direct € Intemet Client i Intemet Server |
—Port setting | USB
- Inf
Pat [Coun =] sesérae 2021} T s comncction porameers ]
[~ RTS/CTS handshaking
—Program setting |7f" Direct " Intemet Client = Internet Server ‘

I~ Passivemode [~ Manual mode onlp

[ Port setting:

I FRiestare the receiver's original baud rate on Disconnect Fort: m Fiec|D: [GPAZKEEST R =] I e port

Internet setting

Host name: Ilncalhnst TEEY
e g I Program setting:
SEnaEy [T Passivemode  [© Kanual mode anly Timeout [me]: | 500 he
I~ | Display datz on sever | Log server everts I'| I Fiestore the receiver's original baud rate on Discornsct
=gl I e I Intemet [ Client - Server ] setting
Histrame: Ilncalhﬂst TCF port: ISDDD
Fassyyord; I

[T Display dataon server. | Log semvern events I~ DHE [sokup

Connect I Cancel |
Figure 2-10. PC-CDU Connection Settings — RS232 and USB
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Table 2-2. PC-CDU Connection Parameters for Ethernet

Parameter Direct Network
Connection Direct
Mode
Port ETHR
TCP port 8002 (default)
Host name IP address assigned to the receiver
Password n/a Assigned during initial setup
[ Connection Parameters

Connection made
’7(-' Direct £ Intemet Client " Intemet Server

~Port zetting:

Port IETHH ~] Host name [19216202
TCP port: ISUUE Password I

[ Program setting:
[ Passivemode [T Manuslmode onlpy  Timesut [ms]: |S00 >

I Restare the receiver's oiginal baud rate on Dissonnest

[~ Internet [ Client - Server | sefting:

Host rame: [£2 105,138,105 TR port: [s000

Fassynnd: I

¥ | Display data on server W Log server events [~ | DNS lockup

Cancel I

Figure 2-11. PC-CDU Connection Settings — Ethernet (Direct Example)
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Power Management

Topcon’s PC-CDU software provides an interface for various
configuration, monitoring, and management functions for the
receiver. For power management of the receiver, PC-CDU displays
the current voltage for the power source.

1.

Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for this procedure.

Once connected, click Configuration » Receiver.

View the Voltages information (Figure 2-12).

External and On Board display the voltage drawn by the
receiver.

2-24

| Genessl | MINTER | Pocifioning | Baee | owes | Paits | Eveniz | Advanced |

Yoltages [volts)

External :

Povet

Iedegees) fromts

Toumraned Eleviiors Missk E3 =
A.r\lem rterng Stahas [read onk)
. E:‘:":: E:n::::“ [ Chaiges | 5
Tempetstue (Cebius dogenes] [
Board tempesoiure ; T [

Fovwns ouljnd modes

[+ Enable Low Power Mode

Extenal ;
On Boad

Vnkages [voils]

On Board :

1T

Refiesh |

Dt | Save | Set ol posameters bo defauks

Figure 2-12. View Voltages Information
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The Net-G3A is intended primarily for use as a permanent or semi-
permanent GNSS Reference Station to establish networks supporting
both real-time and post-processing applications. Observation data can
be streamed through any port to any device capable of receiving and
utilizing it, including TopNET Reference Station software. Data can
also be logged internally to removable CF cards for downloading to
support static or kinematic surveying, mapping, monitoring, and
positioning applications.

The Net-G3A is configurable for single to multiple scenarios,
including the following:

» permanent and semi-permanent Reference Station
e temporary campaign receiver

* RTK or DGPS rover (for monitoring a fixed location, system
monitoring, or mobile data collecting)

This chapter contains information on the basic configuration of the
Net-G3A for some of these applications. Further configuration
information is contained in the PC-CDU manual as well as the
TopNET software manuals.

Regardless of the intended application or configuration software, the
basic setup of the Net-G3A includes the following steps:

» “Configuring the Receiver” on page 3-2
e “MINTER Description and Configuration” on page 3-9
» “Receiver Setup as a Temporary Reference Station” on page 3-21

» “Static Surveying for Reference Stations” on page 3-26
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Configuring the Receiver

The Net-G3A is generally configured as a static Reference Station
that collects GNSS measurement information and logs the data
internally to a removable CF card, streams the data to a central
computer, and possibly connects directly to one or more radios (or
any combination of these configurations). Topcon's PC-CDU and
TopNET software are used to manage and configure the various
functions of the receiver. Configuration settings are saved to the
NVRAM of the GNSS receiver board and are reflected when using
the MINTER.

The full range of both PC-CDU and TopNET configuration and
operation are outside the scope of this manual. For more information
on any of the procedures in this section, or on PC-CDU or TopNET,
refer to the appropriate manual available from Topcon.

Once you have established a connection between the receiver and the
computer, you will be able to:

* configure the receiver and its components

 send commands to the receiver

» download files from the receiver’s memory

* load a new OAF and other configuration files to a receiver

The following is an example of a configuration for the Net-G3A as a
Reference Station supporting internal data logging and real-time
mobile unit support using a radio for transmission of GNSS
correction data. This configuration uses PC-CDU to apply the
appropriate parameters.

Do not make other changes without consulting the
[WARNING]) PC-CDU Reference Manual.

1. Connect the receiver and a computer using one of the methods
described in “Connecting the Receiver and a Computer” on
page 2-15.
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2. Start PC-CDU, and connect to the receiver according to the
settings described in “PC-CDU Connection Parameters” on
page 2-22.
Once a PC-CDU connection with the receiver has been
established, the current communications settings—such as port
name, baud rate (if applicable), and flow control (if applicable)—
display in the lower-left corner of the main window of PC-CDU.
A timer begins to count up in the lower-right corner as well
(Figure 3-1).

[ 1o NET-G3IA ID:KRA4MORPNUO EEX

File Corfiguration Tools Floks  Help

GPS Satellites (10) Geo |z | Target| GLONASS Satelites (8]
# | EL] az[calmpz] 2o 1o ss| Let 55°43133423'N Snlfn| EL[ azfcalmpPafac] 7of 85
a1* 29+ 128 45 3 34 48 63 ne LomITOFORAMTE  Poptaet o Taon 53 53 ap 48 153 0ov

17 22 3B 43 2 28 40 65 o o [E2TEEEM 2 3 32 234 51 50 45 45 185 00+
12¢ 4+ 38 38 15 16 35 1 16~ EMS Fos: 29898 m 23 03 40+ 304 50 48 42 42 101 00+
210 W 41 Z 27 185 00 pwe v n0aa e D6 M 32 80 46 45 41 M 185 0D
19 9. 24 40 23 23 7 165 00+ PDOP 13303 1500 18- 18 43 42 40 41 180 00+
W e 2 4T K/ B\ P79 00 (standalone) 02 7+ /0 4 0B\ W R8O
11 B2 51 ® 3 7 195 00+ 0808 7 24 47 47 W 7T G O
05 4+ 43 3@ 1110 1 16 D9 2 22+ 134 46 46 7 3 0D

32* B4+ 266 B4 44 AV 4 Oy e

11% B3~ 240 52 44 44 27 175 00+ Receivertime:17:4324
Receiver date]3. 03 2003
Clock offset: +0.1771 ppm
Osc. offset:  -0.0899 ppm
Tracking time: 03:05:46

COR4, 115200 00:00:01

Figure 3-1. PC-CDU Connection Established

3. Click Configuration » Receiver.

change; otherwise, the receiver will not register the

@ Click Apply after making any configuration
change.
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4. Click Set all parameters to defaults (Figure 3-2).

Set all parameterto defaults |

[ Receiver Configuration [
| Genessl | MINTER | Pociioning | Baee | Rlorees | Ptz | Eveniz | Advarced |
{degueec) o SourATk Vikages [vols)
T Elervaliors Mask E3] Erwmal: 27
Aniznna Arkerna Stotur read on] O Boaid
 Inteinal Curertlnpaa: [0 Chager —
& Exteimal | B
™ Esd. DT Status —& =
Temperatun [Cobis dogeess] [—
Board lempesafure : [ —
Pow oulgrst maodes: Tuan onloll Shals
[ ] [ |
¥ Enable Low Powsr Mode I =
Refiesh | |
Ed | Save I et oll povometens o defauky I

Figure 3-2. Set All Parameters to Defaults

5. Click the MINTER tab, configure the following settings
(Table 3-1), and then click Apply (Figure 3-3).

Table 3-1. Receiver Parameters for the MINTER Tab

Parameter

Setting

Recording interval

Enter 15 seconds. (This variable depends on post-
processing requirements.)

Elevation mask
angle

Enter 15 degrees. Five degrees (default value) is
recommended for base operations.

File name prefix

Enter the last 3 digits of the receiver’s serial number.

FN key mode

(starts/stops data recording using the FN key)

For Static data recording, select LED blink mode switch.

3-4
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x|
Genessl MINTER | Pooatunrg | Bave | Hove: | Puts | Events | Ardvarse |
Pleceedng verval: [150 tseconds] PN kay mods
Flevalinmosh fuLoghls:  [5 Kegress] ' LED birk mode swiich [ Occupsbon mode sviich
Fin s grelee [les il st collaction dynami:
Eibvwys aggeerad s e e ) E
Fies Comation: ke Dt reconting auo-stast
1 Logkle i~ AFAM = o = 0n s

Fuomate: Fie Holalion Mods FAM| paasetes

Fecording interval : 1.00 [zeconds] 5:4 key mo.de%
Elevation mask far Log file : |1 5 [degrees) *+ LED blink maode switch

File name prefix : log
Reliesh sy |
OF | _ Gt | Save | Senolpacsmetecs o datouks |

Figure 3-3. Configure MINTER for Static Data Recording

6. Click the Positioning tab, make sure the Elevation mask is set to
5 (default value), and then click Apply.

Ed Receiver Configuration

Ganarsl | MINTER [Possorng | Base | Rowee | Poms | Evets | Acvancad |
Postioning Moda Enabin Soltons Sololte manngemet
& Swndolons = Sundakine Satolitos vacked Satelites wsod in pos
DGPS [Coce Didareeicl) | [ DOPS [ GPS [< GLOMASS | | 7 OPSI= OLOMASS
FTE Float
AT Fosd = GFE  OLONASS |wiaasg |
Soralkp Humborng

 Fraguency Chaneel Number  ( Siot Hu
Elervaion mask |

Gt on e
CFmask: [0 2
M |
v - 9 = [= 15F |
- AFF WFF EF
Elewation mask |_15 SFF NFF VF
[degree] : §FF 1rFF 1BF |
Corsprd Dot - [W4 =] I lono-Comecton asglock | Monetoloc] Alwuse | Monetouse|
Oohm Poromaters |+ TroperComecion

Fgtash

Figure 3-4. Configure Receiver Positioning — Elevation Mask

7. Click the Base tab, set the following parameters (Figure 3-5 on
page 3-6), and then click Apply.

* Base Station Coordinates — Select the point to which the
entered coordinates are referred: Phase Center L1 or Antenna
Reference Point.

* Antenna Type — select the desired antenna type from the list
of NGS standard antenna names.

* Antenna position — enter Lat, Lon, and Alt values using one
of the following methods:

— If known, type in the values.
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— Click Get from receiver.

ST

The reference geodetic coordinates specified on this
tab relate to the antenna L1 phase center.

8. Continue with step 8 on page 3-6 for RTK surveys or step 9 on
page 3-7 for other configurations.

® Fhase Center L1

£ Receiver Configuration

Alt:

Lat: ,?‘ 42 1097783 "N w |  Getfrom receiver) | e e
Lon: [121 <[4z * [750060  *[w ~

160.4666

Figure 3-5. Base Configuration

9. For RTK surveys, click the Ports tab, set the following port
parameters for the serial port (Table 3-2), and then click Apply
(Figure 3-6 on page 3-7).

ST

For post-processed surveys, keep the default values
for these parameters.

Table 3-2. Receiver Parameters for the Ports Tab

Parameter Base Receiver
Input n/a (Leave the default, “Command”.)
Output Select the type and format of differential corrections.

Period (sec)

Enter the interval at which the receiver transmits
differential corrections.
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Table 3-2. Receiver Parameters for the Ports Tab (Continued)

Parameter Base Receiver

Baud rate Select a baud rate to use for transmitting differential
messages from the receiver board to the modem module.

The baud rate must match the modem’s serial port speed.

RTS/CTS Select to enable handshaking.

£l Recuives Conligu ation
Genesl | MINTER | Positoning| Bate | Rower Pute | Evenis | Advanced

Sosl | Paratel| Mo | USE | Ethenet | TCP |
o T r 2 Haadiale |11° =
Otgad: Mo - P»..,![.Jl 5| ATS/ET
Smap PR Comend L Dasdrate 115200 =
Oupis: [Hane =] Peiedia: | ™ RTS/ATS
) Jrgut; | Command - Busdrale: [0400 =
Seial C
Duget; [CMA - Period [1]: || ]  RISZIS
SaislD  legd:  Command - Bl [115200 =]
[ Intied pggar: [Hone =] et [ ™ RTS/TS
|
. Iput : IEommand 'l Baud rate : |334DD 'l
Serial C
Output: |CMR A Period (2] : |1.UU W RTS/CTS

Figure 3-6. Base Configuration for RTK Surveys — Ports

10. Click the Advanced tab, and then the Multipath tab. Set the
following parameters, and click Apply (Figure 3-7).

* Code multipath reduction — enable
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* Carrier multipath reduction — enable
=
Genessl | MINTER | Peastinrg | Basm | Fove | Pute | Events Advorced |
At lnkrsemeracr. Wulipath Reduchion | Loy Momagernes | Estrana Faesparrey | Fows Datia Morsagraset | Ot |

o Cexte rindiguathy et

mesicon] o]

OF. I Lt Save Gualnﬂunumhdefml

Figure 3-7. Configure Mulitpath Parameters

11. Click OK to save the settings and close the dialog box.

Once the receiver is configured, the configuration will remain
until you change it using PC-CDU or clear the NVRAM.

For more details on the settings available for configuring the Base
and Rover receivers, refer to the PC-CDU Reference Manual.

12. Continue with other configuration activities or click File »
Disconnect, and then File » Exit to quit PC-CDU.

Disconnecting before exiting ensures proper port management.

exiting to eliminate possible conflicts with the

@ Disconnect the receiver from PC-CDU before
management of the computer’s serial ports.
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MINTER Description and
Configuration

The Minimum INTERface (MINTER) consists of two keys (power
and FN) that control the receiver’s operation, four LEDs that display
the receiver’s operational status, and two LEDs that display the power
status (Figure 3-8).

STATLED LINKLED Power LEDs Function Button

Power Button

/— ]

REC LED RX/TX LED
Figure 3-8. MINTER

The MINTER performs the following functions. For more
information about using the MINTER, see “MINTER Operation” on
page 3-16.

* Turns the receiver on or off; puts it in Sleep mode.
* Turns data recording on or off (FN button).
» Changes the receiver’s information mode.

* Shows the number of GPS (green) and GLONASS (orange)
satellites being tracked (STAT LED).

Shows the data recording status (REC LED).
* Shows each time data is recorded to the memory (REC LED).
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» Shows the status of post-processing mode (static or dynamic)
when performing a Post-Processing Kinematic survey with the
help of the FN key (REC LED).

» Shows the power status for the receiver (PWR LEDs).
Use PC-CDU to configure MINTER settings. The procedure below

describes the most common settings; refer to the PC-CDU Reference
Manual for other possible MINTER configurations.

Clearing the receiver’s Non Volatile Random
@ Access Memory (NVRAM) will return all settings
made using PC-CDU to the factory default settings.

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for this procedure.

2. On the Connection Parameters dialog box, enable RTS/CTS
handshaking (Figure 3-9).
See “PC-CDU Connection Parameters” on page 2-22 for details
on setting other parameters.

3. Click Connect.

[ Connection Parameters

" Interriet Client " Interriet Server |

or seltn
Port [cor1 =] Baudrate: [115200 | I Infrared port
E [ RTS/CTS handshaking

4

Frogram selting
[~ Pessivemode [ Mfnusimodeonly Timeoutfms [500 = ‘

iginal baud rate on Dissonnect

I¥ RTS/CTS handshaking =

TR port: (2000

e I DN lookup

Figure 3-9. Connection Parameters — MINTER Settings

4. Click Configuration » Receiver, and then click the MINTER
tab. Set the following parameters, and click Apply (Figure 3-10).
See the following pages for parameter descriptions:

* Recording interval on page 3-11
e Elevation mask for log file on page 3-11
* File name prefix on page 3-11

3-10 NET-G3A Operator's Manual



MINTER Description and Configuration

* Always append to the file on page 3-12

* Files Creation mode on page 3-12

* Automatic File Rotation Mode (AFRM) on page 3-12
* FN key mode on page 3-13

* [nitial data collection dynamic mode on page 3-14

* Data recording auto-start on page 3-14
x|
General  MINTER | Posiioning | Base | Rover | Pans | Events | Advanced |

Recording interval : 100 | (seconds) ’rm key mode

Elsvstion mask for Logle:  [5 [deaes] & LED blink mods switch ¢ Decupation mode switch
File name prefix log Initial data collection dynamic mod
o eyl i (G Stallc € Kinematiz
Files Creation mode: Data recording auto-start
[ﬁ Log file " AFRM ‘ ’7(? off © 0On  Always

[~Automatic File Rotation Mode ([FRM] parameters

Fesfad [ses] ; [3600 Files ftatel - [0

Phase (sec]; [0 Files lierma] |0

I= Automatically remeve old fies

Refiesh | Appy |

Exit Save | Setall parameters to defaults
I

Figure 3-10. Receiver Configuration — MINTER Tab

Recording Interval parameter This parameter specifies the message
output interval into the log file when the MINTER FN button (pressed
for 1-5 seconds) activates data logging. This setting is used for both
logging a single log file and logging receiver data in AFRM mode.
Values are 1-86400 seconds. The default value is one second.

Elevation Mask for Log File parameter This parameter specifies the
minimum elevation angle for the satellites whose data will be put in
the receiver files logged when pressing FN. The default value is five
degrees.

File Name Prefix parameter This parameter specifies the prefix
added to the names of receiver files created when pressing FN. The
prefix can be up to 20 characters long. The default value for the Name
Prefix is “log.”

Log file names have the following structure:
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<prefix><month><day><sequential lowercase letter><numeric
portion>

The file name depends on both the file creation time (month and day)
and additional letter and numeric suffixes to avoid confusion between
files created on the same day.

Always Append to the File parameter If you want new receiver
data to be appended to an existing log file, enter the desired file name
in this parameter. The setting can be up to 20 characters long.

Files Creation Mode parameter This parameter has the following
operation modes:

* Log file — If the log file radio button has been selected, pressing
the FN button closes the current log file. If data logging is off,
pressing FN opens a new log file.

* AFRM - If the AFRM radio button has been selected, pressing
FN enables this mode. If AFRM has been enabled, pressing FN
disables this mode.

Automatic File Rotation Mode (AFRM) parameters TPS receivers
are capable of automatically rotating log files. During a “file rotation’
event, the receiver closes the current file and opens a new one
according to a user-defined schedule. The Period and Phase
parameters specify this schedule. File rotation launches the moment
the receiver time module Period is equal to Phase. More precisely, a
new log file opens immediately before the scheduled epoch causing
data tagged with this epoch to be recorded to the new log file.

’

When opening a new log file, the receiver enables the default set of
messages outputted with the default output period. Both the default
set of messages and the default output period are programmable.

* Period — specifies the time duration of each log file created in
AFRM mode. Values are 60 to 86400 seconds; default value is
3600 seconds.

* Phase — specifies the “phase” (constant time shift) for creating
multiple log files in AFRM mode. Values are 0 to 86400 seconds;
default value is zero seconds.
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* Files (total) — a counter that specifies how many multiple log files
must be created in AFRM until this mode automatically turns off.
This counter decrements on every file rotation until its value
becomes zero, then file rotation automatically stops. The counter
initializes with AFRM.

Note that a log file opens immediately after turning AFRM on.
This startup file is not considered a file rotation event; the AFRM
counter will not decrement.

Values are 0 to [231—1]; default value is O (zero). Zero means that
an unlimited number of log files will be created.

@ The receiver’s memory holds up to 1024 files.

* Files (remain) — specifies the number of files left for the receiver
to create in AFRM. Values are 0 to [231—1]; default value is zero.

* Automatically remove old files — when no free memory is
available to log data, automatically removes the earliest log file. If
this parameter is enabled, your receiver will erase the file with the
earliest file creation time/date. AFRM must be enabled to use this
FIFO (First-In, First-Out) feature. The default value is off
(disabled).

FN Key Mode parameter Use these two radio buttons to program
how the receiver will react when pressing the FN key.

* LED blink mode switch — pressing FN will toggle between the
MINTER’s normal/extended information modes and start/stop
data recording of Static survey.

— FN pressed for less than 1 second: changes the information
mode (Normal or Extended Information Modes).

— FN pressed for 1 to 5 seconds: starts or stops data recording
(Static post-processing mode).

* Occupation mode switch — pressing FN (less than one second)
will insert into the corresponding log file a message indicating
that the survey type has been changed from static to kinematic, or
vice versa. If the REC LED blinks green, the current mode is
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dynamic, if it blinks orange, the current mode is static. For more
details, see Table 1-1 on page 1-12 and refer to the PC-CDU
Reference Manual.

Initial Data Collection Dynamic Mode parameter These radio
buttons specify the starting occupation type descriptor inserted at the
beginning of receiver files logged. Select Static or Kinematic to
specify that the corresponding log file will start with a static (STOP)
or kinematic (GO, Trajectory) occupation, respectively.

Data Recording Auto-start parameter These radio buttons allow
you to program your receiver’s behavior in the event of a power

failure.

Table 3-3 describes the different scenarios available and the results
after power is restored to the receiver. “Specified file” refers to the file
name entered in the Always append to file field.

Table 3-3. Data Recording Parameter Behavior

logged to file
specified.

not resume when

power is restored.

resume data
logging to the
same file when
power is restored.

Before Enabled Radio Button Results

Power

Failure Off On Always
Receiver data | Datalogging will | Receiver will Receiver will resume

data logging to the
same file when
power is restored.

Receiver data

Data logging will

A new log file will

A new log file will

power is restored.

power is restored.

logged to not resume when | open when power | open when power is

default file. power is restored. | is restored and restored and data
data will log to will log to this file.
this file.

Filespecified; | No file will open | No file will open A log file with this

receiver data with this name. with this name. name will open and

logging not Data logging will | Data logging will data logging will

started. not start when not start when start after power is

restored.
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Table 3-3. Data Recording Parameter Behavior (Continued)

Before Enabled Radio Button Results
Power
Failure off On Always
No file Data logging will | Data logging will A log file with a
specified; not start when not start when default name will
receiver data power is restored. | power is restored. | open and data
logging off. logging will start
after power is
restored.

Also, if Always is enabled, the receiver will automatically start
logging data (to a newly created or an existing file) in the following
three cases:

 After turning on the receiver using the power button.
* After resetting the receiver (using PC-CDU).
* After taking the receiver out of Sleep Mode.

x

General MINTER | Postioning | Base | Flover | Ports | Events | Advanced |

1.00 (seconds] "FN kep mode

|—5 (degrees] & LED blink mode switch ¢~ Occupation mode switch
File name prefis log Initial data callection dynamic mad
Alnays append to the fi - (“‘ Stallc € Kinzmatic

Data recording auto-start
‘ ’76‘ 0ff © 0On  Always

[~Automatic File Rotation Mode ([FRM] parameters

Fesfad [ses] ; [3600 Files ftatel - [0

Recording interval :

Elevation mask for Log file :

I'F\\Es Cireation mode

“ Loglile " AFRM

Phase (sec]; [0 Files lierma] |0

I= Automatically remeve old fies

Refiesh | Appy |

Exit Save | Setall parameters to defaults
I

Figure 3-11. MINTER Tab
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MINTER Operation

To turn on/off the receiver, press the power button (Figure 3-12).

* When turning on, press the power button until the MINTER’s
LEDs briefly flash.

* When turning off, press the power button until the PWR LEDs
turn red, then release.

Press the power button for about 1 Power Button
second to turn the receiver on/off.

Figure 3-12. Power Button Functions

To start/stop logging data, press the FN button for 1 to 5 seconds
(Figure 3-13).
* During data recording, the REC LED is green. Use PC-CDU to

set the recording time interval. See “Recording Interval
parameter” on page 3-11 for details.

* The REC LED blinks green each time data is written to the
receiver’s memory.

e If the REC LED is red, the receiver has run out of memory, has a
hardware problem, or contains an improper OAF (see “Option
Authorization File (OAF)” on page 1-21 for more information).

Use PC-CDU to enable the desired FN key mode in the receiver,
either “LED blink mode switch” for static surveys or “Occupation
mode switch” for kinematic surveys. See “FN Key Mode parameter”
on page 3-13 for details.
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Each time you turn off or on data recording, either a new file opens or
data appends to a particular file. See “Always Append to the File
parameter” on page 3-12 and “Files Creation Mode parameter” on
page 3-12 for information on setting these functions.

Press the FN button for 1-5 Function Button
seconds to start/stop data logging.

Figure 3-13. FN Button Functions

To toggle between post-processing modes, press the FN button
for less than 1 second when “Occupation mode switch” has been
enabled using PC-CDU.

To change the information mode of the receiver, press the FN
button three times for less than 3 second when “LED blink mode
switch” has been enabled using PC-CDU.

To change the baud rate of the receiver’s serial port, press the
FN button for 5 to 8 seconds. This is useful if the data collector does
not support the rate that the receiver port is set to.

After about five seconds, the REC LED becomes red. Release the FN
button during the next three seconds.
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Using the Web Interface

The Net-G3A includes a built-in Web server that allows you to
configure and monitor the receiver via a Web user interface (or Web
interface). The following Web browsers are recommended for
accessing the receiver:

* Windows Internet Explorer 6.0 or later
* Mozilla Firefox 2.0 or later
* Opera 9.0 or later

The built-in Web server and Web interface use HTTP/HTTPS
protocols for communication.

Accessing the Net-G3A through the
Web Interface

Before accessing the Net-G3A using the Web interface, determine
whether the valid network parameters (IP address, gateway, etc.) are
specified in the receiver. Refer to “Configuring an Ethernet
Connection Using PC-CDU” on page 2-19 for details regarding the
network parameters.

1. Open a recommended Web browser.
The browser window appears.

2. In the Address or Location bar of the Web browser, type one of
the following addresses:

http://ipaddress<:port number>
or
https://ipaddress<:port number> (if SSL is enabled)

where ipaddress is the receiver’s IP address; port number is the
port number you should specify if set to a number other than the
default port number (port 80 for HTTP, and port 443 for HTTPS).
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The main page is displayed.

B 8 e Hgoy [oomais [od (e

o -c A e, 188 0,18 P
#¥ TOPCON
o .

Figure 3-14. Web Interface — Main Page

When accessing the Web interface via SSL
communications, a warning may appear stating the
security certificate was issued by a company you
have not chosen to trust. You can safely ignore this
warning and continue with the login procedure.
Your communications will use SSL.

3. Log in through the Web interface by entering the login name and
password in the appropriate fields.
The default login and password are fopcon. Login names and
passwords are case-sensitive and can be up to 12 alphanumeric
characters.

Enter Your Login and Password

Enter

Figure 3-15. Web Interface — Login

4. Click Enter.
After logging in to the Web interface, you can view and modify
the receiver parameters.

login name and password; however, you will be

@ You can access the receiver without entering the
restricted to view-only activities.
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Understanding the Web Interface

The Web interface is divided into two frames:

» Navigation menu — contains a list of menu items through which to
access receiver functions.

¢ Content area — contains the various Web interface screens based
on the item selected in the navigation menu.

88 Topeon Receiver Web Interfce

£ TOPCON

Navigation Menu

Content Area —

Figure 3-16. Web Interface Elements

Some of the screens in the Content area have the Submit button.
Click it to apply changes made to the receiver parameters.

Building an Antenna Cabling
System

A cable system running between the antenna(s) and the receiver must
meet certain requirements to provide the minimum level of signal
loss, thus delivering a quality signal. These requirements include the
following:

* Cable length should be kept to a minimum.
Topcon offers cables of various lengths, from 3 to 100 meters.

* Use only low-loss coaxial cables.
For distances of up to 10 meters, it is recommended to use
Topcon’s RG-58 cable. If a greater length is required (up to 30
meters), it is recommended to use Topcon’s RG-8 or LMR-400.
For LMR-400 at 1600 MHz, the attenuation is 0.2—-0.1 dB/meter.
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* Beyond 30 meters, consider using in-line amplifiers or extra low
loss cables.
Topcon offers 30 and 60 meter cable options using LMR-400 and
a 100 meter cable using LMR-600. For LMR-600 at 1600 MHz,
the attenuation is 0.1 dB/meter.

* The total attenuation of the cable system should not be more than
10-12 dB at 1.6 GHz.

For installation with multiple receivers and a single antenna, use
GNSS antenna splitters. The splitter(s) should normally have one RF
output that passes DC current from the connected Net-G3A receiver
through the splitter to the antenna. The other RF outputs should block
DC current to prevent antenna damage. Also, the splitter should have
a minimum of 20 dB RF isolation between its outputs to eliminate
possible interference between the receivers connected with this
splitter.

For applications where power is supplied from a separate
source, consider using the bias tee. The bias tee typically has two
coaxial connectors and a connector to power the antenna’s LNA from
an external power supply. One of the coax connectors is usually
marked RF + DC and will have DC appearing on its center pin. The
other connector is marked RF and it is DC-blocked. The remaining
connector marked DC is where power should be applied.

Receiver Setup as a Temporary
Reference Station

The typical permanent or semi-permanent Reference Station setup
has the Net-G3A in a secure location with access to power and
communication links as required. The antenna location has been
surveyed very accurately and is free of signal obstructions and
interference (RF, multipath, etc.).

As a temporary Reference Station, certain steps must be performed to
ensure proper data collection. The following sections detail the use of
the Net-G3A in a temporary Reference Station configuration.
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Before logging data, make sure the receiver contains current almanac
and current ephemeris data (see “Collecting Almanacs and
Ephemerides” on page 2-14).

Step 1: Set up the Receiver

1.

Place the receiver in the predetermined location. A sturdy shelf or
out-of-the-way table may be a convenient spot.

See “Net-G3A Dimensions” on page A-2 for
measurement details regarding the placement of
screw holes for a permanent mount.

For a permanent mount, drill four screws through the mounting
location (shelf) and into the receiver’s mounting holes.

Connect the power cable to an available and grounded outlet. See
“Powering the Receiver” on page 2-11 for more details and
precautions.

Connect the antenna cable. If recording data to an external device,
such as a USB hard drive, connect it to the receiver using the
required communication cable.
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To Grounded
Power Outlet

To Power
Port 1

To GPS
Antenna Port

To GPS
Antenna

l l

Figure 3-17. Mount Receiver and Connect Cables

Step 2: Measure Antenna Height

The location of the antenna relative to the point being measured is
very important for both surveys in which the elevation of the point is
important and in surveys for horizontal location only. Horizontal
surveys are often larger in area than can reliably fit on a flat plane;
therefore, the antenna adjustment must be done in three dimensions
and then projected onto a two dimensional plane.

The receiver calculates the coordinates of the antenna’s phase center.
To determine the coordinates of the station marker, the user must
specify the following:

* Measured height of the antenna above the station marker

* Method of measuring the antenna height
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* Model of the antenna used
Antennas have two types of measurements:

¢ Vertical — measured from the marker to the antenna reference
point (ARP) located on the bottom of the antenna at the base of
the mounting threads.

* Slant — measured from the marker to the lower edge of the
antenna slant height measure mark (SHMM).

The point to which all measurements are being referenced is called
the Phase Center of the antenna. This is analogous to the point at
which a distance meter measures in a prism. A user must enter the
prism offset to compensate for this point not being at a physical
surface of the prism. For a GNSS antenna, the offset is entered
depending on the type of measurement taken.

* For vertical, the offset is simply added to the measured vertical
height to produce a “true” vertical height.

* For slant height, the vertical height must first be calculated using
the radius of the antenna, then the offset can be added.

The offsets are different because of the difference in location between
the slant measuring point and the vertical measuring point.

1. Measure the antenna height above the control point or marker,
either the slant height or the vertical height (Figure 3-18 on
page 3-25).

2. Record the antenna height, point name, and start time in the field
notes.

The height of the antenna and it’s offsets depend on the type of
antenna used. Refer to the antenna’s documentation for details.

Refer to the antenna’s offset measurements card for
measurement and offset details.
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Reference Surface for
Offset Measurements

______QD.___________

Figure 3-18. Measure Antenna Height — Example

Step 3: Collect Data

See the remaining sections in this chapter for more information about
collecting data.

1. Turn on the receiver. The STAT (status) light LED blinks red at
first.

¢ Once the receiver has locked on to one or more satellites, the
STAT LED will blink green for GPS satellites and orange for
GLONASS satellites. A short red blink indicates that the
receiver has not solved a position. Four or more satellites
provide optimal positioning.

* Once the short red blink is gone, the receiver has a position
and surveying can begin; wait for green and orange lights
before beginning data collection. This ensures that the
receiver has the correct date and time and is locked on to
enough satellites to ensure good quality data.

The process of locking on to satellites normally takes less
than one minute. In a new area or after resetting the receiver,
it may take several minutes.

2. Press and hold the FN key (for more than one second and less
than five seconds) to begin collecting data.

3. Release the FN key when the REC (recording) LED turns green.
This indicates that a file has opened and data collection has
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started. The REC LED blinks each time data is saved to the
memory.

\i ; i Use PC-CDU to configure data logging. See

“MINTER Description and Configuration” on
page 3-9 or refer to the PC-CDU Reference
Manual.

Stopping Data Logging

Stop logging data when you need to move the receiver, download
data, or perform maintenance functions.

1. Press and hold the FN key until the REC LED light goes out.

2. To turn off the receiver, press and hold the power key until all
lights go out, and then release.

Static Surveying for Reference
Stations

Static surveying is the classic survey method, well suited for all kinds
of base station surveys. One receiver over a survey marker collects
raw data during a certain period of time. The length of the observation
sessions can vary from a few minutes to several hours. The optimal
observation session length depends on the surveyor’s experience as
well as the following factors:

* the number of satellites in view
* the satellite geometry (DOP)

* the antenna’s location

* the ionospheric activity level

* the types of receivers used

¢ the accuracy requirements

* the baseline length
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Generally, single-frequency receivers are used for baselines with
lengths that do not exceed 15 kilometers (9.32 miles). For baselines of
15 kilometers or greater, use dual-frequency receivers.

Dual-frequency receivers have two major benefits. First, dual-
frequency receivers can estimate and remove almost all ionospheric
effect from the code and carrier phase measurements, providing much
greater accuracy than single-frequency receivers over long baselines
or during ionospheric storms. Secondly, dual-frequency receivers
need far less observation time to reach the desired accuracy
requirement.

After the survey completes, data the receivers collect can be
downloaded onto a computer and processed using post-processing
software (for example, Topcon Tools).

Analyzing Signal-to-Noise
Ratio

Knowing the strength and reliability of the ranging signal transmitted
from the satellites will help determine the quality of the satellite
signals. Use Table 3-4 to help estimate signal quality from a satellite
vehicle.

Table 3-4. Typical SNR Values

SV Elevation C/A channel P1 channel P2 channel
(degrees) (dB*Hz) (dB*Hz) (dB*Hz)
10-20 >35 >10 >10
20-40 >40 >20 >20
40-60 >45 >30 >30
60-90 >50 >40 >40

a. SV = satellite vehicle

If the SNR value of a satellite signal is less than the threshold value
from the table, then pay close attention to this satellite because it can
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potentially cause problems for getting accurate timing and
positioning results.

Using the Anti-Jamming
Suppressor (AJS)

The Net-G3A is equipped with advanced hardware and software
components, called anti-jamming suppressor (AJS). These
components suppress unintentional or intentional narrowband Radio
Frequency Interference (RFI). AJS accurately estimates the
interfering signals and intelligently mitigates them. Once AJS is
enabled, interference mitigation improves the receiver’s resistance to
interference and allows the receiver continuous operation without
degradation of positioning accuracy or loss-of-lock to the satellites in
areas affected by RFI.

To enable AJS:

1. Run PC-CDU.

2. Click Configure » Receiver » Advanced » Anti-Interference,
and then select Auto.

3. Click Apply » OK.

To view textual information about detected in-band interference
signals, enable the JI message using the Manual Mode window.

Working with External Devices

The Net-G3A receiver can be connected with various external devices
for frequency calibrations and time synchronization, external events
time-tagging, meteorological measurements, and differential
corrections distribution.

If you have any problems or questions on using the Net-G3A with
these devices, contact your local Topcon dealer. For contact
information, visit the TPS website at:

http://www.topconpositioning.com/static/dealer_pointer.php
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Receiver and File
Maintenance

If you are post-processing the data after completing a survey, then
download the data from the receiver’s memory to a computer.
Downloading and deleting files also creates space in the receiver’s
memory for the next survey. Occasionally, the receiver’s NVRAM
may need to be cleared to eliminate communication or tracking
problems.

As project expectations expand, the receiver’s OAF may need to be
updated to provide expanded operation and functionality. The GPS
board inside the receiver requires firmware to properly operate and
provide appropriate functionality. As Topcon releases firmware
updates, loading these updates into the receiver will ensure that the
receiver operates at its full potential.

Downloading Data Files from
an Installed Memory Card

After completing a survey, download data files from the memory card
installed in the receiver to a computer or a UMS device for storage,
post-processing, or backup. Also, the memory card holds a finite
amount of files and information, so downloading data prevents files
from being lost. The following steps use PC-CDU to download files,
but any Topcon receiver management software can be used.
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Downloading Data Files to a

Computer

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for information about

this procedure.
PC-CDU automatically appe

ars with the Connection

Parameters dialog box open. If this dialog box is not open, then
click File » File Manager on the PC-CDU main page.

2. On the Connection Parameters dialog box, enable RTS/CTS

handshaking and then click

Connect (Figure 4-1 on page 4-2).

[ Connection Parameters B
Connection mode
(r-‘ Direct  Inteiret Client  Intemet Server |
[~ Port setting:
Pot [coMi =] Baudrate: [115200 =] ™ nared pot

|
[¥ RTS/CTS handshaking

F i

Program sefting

™ Passivemode [~ flanvalmodeonly  Timeoutpme} [500 <

[+ BTS/CTS handshaking

original baud rate on Disconnect

TER park | 2000

stting

Password |

I~ Display data or st

ever v Logsemver events I~ DHE [agkup

Cancel

Figure 4-1. Connection Parameters — RTS/CTS Handshaking

3. Click File » File Manager, and then click the Download path
tab on the File Manager dialog box (Figure 4-2).

x

Download files | Current log fil

Total memory: 47348784 bytes

e | Downlo% pathl
Free memony: 47164824 bytes

Name

Size: | Date | Time

log0323a 7A196  23.09.2002 84352
log523b FE7I5 23092002 &51:53
log03242 GEET  24.09.2002 36261
log0324b 4701 24.09.2002 6260
log0324c 4333 24.09.2002 %6344
log0324d 5130 24.09.2002 35355
log524e 4676 24.09.2002 354:06
log0324f 4162 24.09.2002 26416

Save to: EATESTINGADATA

Using: | Current port [COMZ] | Block. size: |512 bytes b

Downloadl Delete |

I™ Exclusive mode

Refresh I Exit |

[

Figure 4-2. Find Files to Download
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4. Navigate to or create (using the Create button) the folder in
which to download and store files.

5. Click the Download files tab, and select the file(s) to download
(Figure 4-3 on page 4-3).

To select multiple files, hold down the shift key and click on
sequential files to select several files at once, or hold down the
Ctrl key and click on individual files.

x
Daownload files | Current log Fi\el Diovariload Dathl

Tatal memory: 47348784 bytes Free memarny: 47164824 bytes

a

log0324b 4701 24.09.2002
loa(1924c 45933 24.09.2002

logOa24f 4162 24.09.2002

Save to: EATESTIMGADATA

| I~ Exclusive mode
Using: ICurrent port [COR 2] j Block size: |512 bytes j
LDiownload I Delete | Eefresh I Exit |

1

Figure 4-3. Download Files

6. Click the Download button. During the download, status
indicators display next to each file (Figure 4-4).
* Blue indicator — file in queue for downloading.

* Red indicator — file currently downloading.
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EﬂFile Manager

Daownload files | Current log Fi\el Diovariload Dathl

Tatal memory: 47348784 bytes

Free memarny: 47164824 bytes

* Green indicator — file has successfully downloaded.

x|

| Size | Diate |

Timne:

78196 23.09.2002
76795 23.09.2002
5661 24.09.2002
4701 24.09.2002

loal924c 4933 24.09.2002
log0324d 5190 24.09.2002
log0324e 4676 24.09.2002
logOa24f 4162 24.09.2002

Save to: EATESTIMGADATA
[ Blocks: 28

Stop I [elete | Eafreshl Exit

I Ezclusive mode

Using: | Current port [COR 2] 'l Block size: |512 bytes 4

8:43:62
8:61:63
95251
35253
35344
%6365
5:64:06
%5416

19% | Downloading logd923a. ..

Figure 4-4. Download Files — Status Indicators

7. Click Exit on the File Manager dialog box.

8. Continue with other operations, or click File » Disconnect and
then File » Exit to quit PC-CDU.

Downloading Data Files to a UMS

Device
1.

Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for information about
this procedure.

Connect the UMS device as described in “Connecting and
Activating the UMS Device” on page 2-10.

Run PC-CDU. The Connection Parameters dialog box appears.
If this dialog box is not open, then click File » File Manager on
the PC-CDU main page.
On the Connection Parameters dialog box, enable RTS/CTS
handshaking and then click Connect (Figure 4-1 on page 4-2).
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[d Connection Parameters B
Connection mode
((-* Direct " Internet Client  Intemet Server |
[ Part setting
Pot: [COM1 > Baudrate: [115200 =] ™ nared pot
]

[ RTS/CTS handshaking

Program seiting /
I~ Passivemode [~ flanualmode onlp  Timeout[ms: [S00 ~

original baud rate on Disconnect

[¥ RTS/CTS handshaking Jows
. I BT

Passwor: |

™| Display data onjserver. W | Log server events I~ DHE [agkup

Cancel
Figure 4-5. Connection Parameters — RTS/CTS Handshaking

5. Click File » File Manager.

6. In the File Manager dialog box, click the USB Copy tab
(Figure 4-6).

Eﬂ File Manager @
Download fies | Cunent og e | Download path USE Copy |
Intemal Storage USE Storage
ogD2021 UUSE Storage Not Active
logh220s
main ldp
log2z6k
12345
Activate

Figure 4-6. USB Copy
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7. Click Activate, and then click Yes to make the inserted UMS

device ready for copying.

[

Dawnload fles | Curent og e | Download path USE Copy |

Intemal Storage

x|

log0202i
main.ldp

12345

USB Storage Mot Active

log0220s

log0226k

Figure 4-7. Activate the Inserted UMS device

8. In the Internal Storage box, select the file(s) to download
(Figure 4-8 on page 4-7). To select multiple files, hold down the
shift key and click on sequential files to select several files at
once or hold down the Ctrl key and click on individual files.

box with color-coded names.

@ The selected files also appear in the USB Storage

A black file name indicates that the file already
resides on the UMS device.

A gray file name indicates that the file is selected

and is ready for copying.

A red file name indicates that the file cannot be
copied for some reason (either an incorrect file
name or the file is already on the UMS device).
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9. Click Copy. If any file names appear in red in the USB Storage
box, then the Copy button will be unavailable (Figure 4-8).

ﬂ File Manager E

Download fies | Cunent og e | Download path USE Copy |

Intemal Storage USE Storage

Pri23_pni34 BE_W
123abcd5hdef logl202i

12333 12345

Selected 258423933 hytes in 4 files

[ Deactivate

Figure 4-8. Copying Data Files to a UMS device

During the copying process, the REC LED will
@ blink yellow every second. Do not remove the UMS
device until the blinking stops.

Downloading Data Files from a
Removed Memory Card

After removing a memory card from the receiver, the data can be
downloaded using Topcon Link software. A CF card reader in or
connected to the computer is required to access the data on the card.
Before Topcon Link can read data on a Memory Card, the card must
be formatted for Topcon devices.

¢ The device icon for a formatted card will be red.

* The device icon for an unformatted card will be gray.

Refer to the Topcon Link User’s Manual for a
complete description of working with data on a
memory card.

To format a memory card:

1. Insert the memory card into the card reader.
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2. Navigate to the Topcon Memory Cards device directory, and click
the device icon.

3. Click the desired, formatted memory card device icon.
To download data files:

After formatting the card, select and copy, or select and drag-and-
drop, the desired files into a directory on the computer. During the
downloading process, the REC LED will blink yellow every second.
Do not remove the UMS device until the REC LED stops blinking.

File Edit Miew Favorites Tools  Help

GBack M > | ? / ! Search = Folders

Address a H:
Folders X
= ™ Topcon Memory Cards PC-CDU FC-COU
A loglS05a.tps  log0S05b.tps

Figure 4-9. Import From Memory Card

Deleting Data Files from an
Installed Memory Card

A memory card holds a finite amount of collected data. To free up
space for more or new data, delete old data. For more information on
managing the receiver’s memory, see “Managing Receiver Memory”
on page 4-10. The following steps use PC-CDU to delete files, but
any Topcon receiver management software can be used.

You can also configure the receiver to automatically delete files using
the first-in-first-out function (see “Automatic File Rotation Mode
(AFRM) parameters” on page 3-12 for details).

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for information about
this procedure.
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2. On the Connection Parameters dialog box, enable RTS/CTS
handshaking (Figure 4-10).

[# Connection Parameters x|

Conmection mods:
’7(-' Direct " Internet Client " Intemnet Server |

Pott setting

Port: [COM1 ] Baud ate: [115200 =] I Infrared port
¥ RTS/CTS handshaking

Program selting /
I~ Passivemods [~ fianusimodes only  Timeout[ms); [500 =

original baud rate on Dissonnect

[¥ RTS/CTS handzhaking feom
. TCR gt [aonn |

Passward: |

I~ Display datzonserver || Logsemverevents [ DG [ackup

Corce
Figure 4-10. Connection Parameters — RTS/CTS Handshaking
3. Click File » File Manager and select the file(s) to delete on the
Download files tab (Figure 4-11 on page 4-10).

To select multiple files, hold down the shift key and click on
sequential files to select several files at once or hold down the
Ctrl key and click on individual files.

4. Click Delete (Figure 4-11 on page 4-10).

5. Click Yes on the delete files confirmation dialog box. PC-CDU
deletes the selected files.

6. Click Exit on the File Manager screen.
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7. Continue with other operations, or click File » Disconnect, and
then File » Exit to quit PC-CDU.

M

Download files | Current lng fi\el Dowrload pathl

Total memony: 47348784 bytes Free memony: 47164824 bytes

loal924f 4162 24.09.2002

Save to: EATESTINGADATA

| I~ Exclusive mode
Using: m Block size: Im
ann\oadl Dale,lew Refresh I Exit |

[

Figure 4-11. Delete Files

Managing Receiver Memory

When using the receiver in static or dynamic applications, you may
need to know the amount of memory the receiver’s log file occupies.
The specific memory size depends on the type of data being recorded.
Use the formulas below to compute the approximate size of the
receiver’s log files. These equations are based on the default set of
messages.

* SS — the estimated size of one epoch of raw data in the receiver’s
log file (expressed in bytes).

* N - the number of observed satellites per epoch.

When recording only L1 data:
SS =183 + 22*N

When recording L1 and L2 data:
SS =230 + 44*N

Table 4-1 shows the amount of receiver file memory required for the
raw data measurements collected for an hour. The amount of memory
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depends on the total number of GNSS satellites being tracked and

used in position computation, and the recording interval.

Table 4-1. Amount of Memory Required to Store a One Hour File

Recording Interval (seconds)

#SVs
0.1 1 5 15 30
Single-frequency dual-system receiver
Memory needed to record data
6 11 MB 1.1 MB 221 KB 74 KB 37KB
10 14 MB 1.4 MB 283 KB 94 KB 47 KB
14 17 MB 1.7 MB 345 KB 115KB 57.5KB
18 20 MB 2MB 407 KB 136 KB 68 KB
Dual-frequency dual-system receiver
Memory needed to record data
6 17 MB 1.7 MB 347 KB 116 KB 58 KB
10 23 MB 2.3 MB 471 KB 157 KB 78.5 KB
14 29 MB 2.9MB 595 KB 198 KB 99 KB
18 35MB 3.5MB 720 KB 240 KB 120 KB
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Initializing File System

Initializing the file system of a connected receiver erases all of the
receiver’s data files. This process requires two confirmations before
beginning and may take several minutes depending on the receiver’s
memory size.

Initialize File System =]

First confirmation to Q e ey e e e L
initialize file system >

Do you realy wish ta continue?

Tes No

[Edl Initializing Receiver File System

Thig is your last chance to cancel

Second confirmation to initializing the receiver's file system.
T . —> Press Startto continue with
initialize file system initializing.

Cancel |

[ Initializing Receiver File System [

13960 of 1960

File Systern Information ;I Inltlal ization

ersion: 3000103 i 1593 of 1960
In progress
Block size: 16376 bytes
Elocks 1959
Total memary: 32080584 bytes [
Free mermory, 32080584 ytes
Bad blocks: 0
Write verify: fast
B e o e e «4— |nitialization complete
Blocks for files: Bz7en
Physical mermony: 32112640 bytes
-]

Refresh Save to file |

Figure 4-12. Initializing the File System

When the receiver’s memory is initialized, information on the file
system and physical memory displays.

¢ Refresh — reloads the information.

» Save to file — saves the files system and physical memory
information to a text file.
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Ok — closes the dialog box.

Always initialize the file system on the installed CF

@ card before the first use. It is recommended to
reinitialize the receiver file system on a regular
basis.

Setting Raw Data & Position
Update Rates to 50 Hz

This procedure sets the receiver to output measurement data and
position information at 50 Hz.
1. In PC-CDU, click Tools » Receiver options.

2. Make sure that the Position update rate (Hz) and Raw data
update rate (Hz) options display 50 in the Current column, and
then click Exit.

3. Click Configuration » Receiver.

4. Click the Advanced tab, and then the Raw Data Management
tab. Set the following parameters, and then click Apply:

* Raw Measurement Update Rate, Update Rate — set to 20 ms.
* Position Update Rage, Update Rate — set to 20 ms.

5. Click Refresh, and examine the values in the Current Update
Rate fields. They should display 20.

6. Once verified, click OK.

When requesting any data recording or output with a period—that is,
a recording or output not directly supported by the current state of the
receiver—PC-CDU will launch the Output Period Setup Wizard. This

wizard performs the same steps described above. For details on the
wizard, see PC-CDU Reference Manual.
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Managing Receiver Options

The Option Authorization File enables certain functions, features, and
options in the receiver, such as the following:

* the type of signal (L1 or L1/L2) the receiver will process
* the amount of data the receiver will store in the memory
* the rate at which data will be transmitted or received

For a complete list of available options and details, consult with your
Topcon dealer.

Checking the Receiver’s OAF

The receiver’s OAF lists all enabled or disabled features. To

determine if a feature is turned on or which features are available,

check the receiver’s OAF using available Topcon receiver

management software. The following steps use PC-CDU to view

options.

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for this procedure.

2. Click Tools » Receiver Options. The Options Manager dialog
box (Figure 4-13 on page 4-15) contains the following
information:

* Option name — a name/description of the option
* Current — the current status of the option

* Purchased — if the option is purchased or not

* Leased — if the option is leased or not

» Expiration date — the date the option will be disabled, if
applicable

Because options can be both purchased and leased, the “Current”
status of the option displays the currently effective value. Option
values can be one of the following:

e -1 or “-----" — the firmware version does not support this
option
* 0 — the receiver option is disabled
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* positive integer — the option is enabled
* yes or no — the option is either enabled or disabled

3. When finished, click Exit on the Option Manager dialog box,
and then click File » Disconnect to disconnect from PC-CDU
(and prevent conflicts with serial port management).

& Option Manager @

Option name Current Purchased Leaszed E=p. date -
,W GPS on on on 16.03.2009
GLOMASS ah an on 1E.03.2003
Initialize file: system L1 on on on 16.03.2009
Lz on on on 16.03.2009
Clear HYRAM Cinderella an an an 16.03.2009
Reset receiver Position update rate [Hz) 100 100 100 16.03.2003
e — Faw data update rate [Hz] 00 100 100 16.03.2009
Code differential Base ah an on 1E.03.2003
Code differential Rover on on on 1E.03.2003
RTK Base on on on 16.03.2009
RTE Rover (Hz) 100 100 100 16.03.2009
temory [tb] ED44 2048 E044 16.03.2009
Co-0p Tracking an an an 16.03.2009
1-PPS Timing Signal 2 2 2 16.03.2009
Event Markers 1 1 1 1E.03.2003
In-Band Int. Rejection dizabled a 1 06.03.2009
Multipath R eduction ohn on an 16.03.2008
Frequency Input on on on 1E.03.2009
Freq. Lock and Output an an an 16.03.2009
Serial Port & [Kbps] 460 460 460 16.03.2009
Serial Port B [Kbps] 460 460 460 16.03.2009
Serial Port C [Kbps] 460 460 460 16.03.2009
Serial Port D [Kbps] 460 460 460 16.03.2009
Infrared Fort disabled on on 1E.03.2003
Parallel Port disabled on on 16.03.2009
Sp.Sp. Freq Hop, dizabled on an 16.03.2008
Sp.5p. Direct dizsabled on on 1E.03.2009
RalM disabled on on 16.03.2009
Daturng support ohn on an 16.03.2008
tdagnetic azimuth on on on 1E.03.2009
Geoid height an an an 16.03.2009
“way Point Mavigation dizabled on an 16.03.2008
WAAS on on on 1E.03.2003
OMNISTAR dizabled on on 16.03.2009
DGPS mode an an on 1E.03.2003
RTE mode [Hz] 100 100 100 16.03.2009
RATCH Output CP CP CP 16.03.2009
RTCH Input 5 5 5 16.03.2009
CHA Output 1 1 1 16.03.2009
CMA Input 1 1 1 16.03.2009
Reserved on on on 16.03.2009
COU Suppart dizabled on an 16.03.2008
Carrier Phass on on on 1E.03.2003
Ethernet Port on on on 16.03.2009
USE Part ah an on 1E.03.2003
ADU 1 1 1 16.03.2009
Authorization 3 3 3 16.03.2009
JPS Output 1 1 1 16.03.2009

JPS Input 5 5 5 16.03.2009

Refresh | Load | | E it

Figure 4-13. View Option Manager
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Loading an OAF

Topcon Positioning System dealers provide customers with OAF
files. If you purchase an updated OAF for the receiver, you need to
load it before you can use the new feature. The following steps use
PC-CDU to load the option file.

For OAF related questions, e-mail TPS at options @topcon.com and
include the receiver’s ID number.

1.

Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for this procedure.
Click Tools » Receiver Options.

Click Load at the bottom of the Option Manager dialog box (see
Figure 4-13 on page 4-15).

Navigate to the location of the new Option Authorization File.

OAFs have .jpo or .tpo extensions and are unique to each receiver
(Figure 4-14).

Look in: I:__*fj Desktop j &

r-A My Documents
= My Computer
K= My Metwork Places

File name:

Open

Filez of type: IJPS Options files j Cancel

Figure 4-14. Load OAF

Select the appropriate file, and click Open (Figure 4-14). The
new receiver option loads onto the receiver, and the Option
Manager table updates.

When finished, click Exit on the Option Manager dialog box.

Click File » Disconnect to prevent conflicts with serial port
management.
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Resetting the Receiver

If the receiver stops responding via buttons or software, then perform
a hard reset. A hard reset should only be performed when the receiver
is powered on and not otherwise responding.

A hard reset simply cycles the receiver’s power. It
does not erase information stored in the receiver’s
memory.

To perform a hard reset:

1. Remove the front door.

2. Insert a paper clip or any pointed stick small enough to fit into the
pinhole (Figure 4-15).
3. Gently press the reset button for about one second until the unit

powers off.
C E
7

Recessed Hard
Reset Button

NET-G3A

Figure 4-15. Reset the Receiver
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Clearing the NVRAM

The receiver’s Non-Volatile Random Access Memory (NVRAM)
holds data required for satellite tracking, such as ephemeris data and
receiver position. The NVRAM also keeps the current receiver’s
settings, such as active antenna input, elevation masks and recording
interval, and information about the receiver’s internal file system.

There are times when clearing the NVRAM can eliminate
communication or tracking problems. Clearing the NVRAM in your
receiver can be interpreted as a “soft boot” in your computer.

After clearing the NVRAM, your receiver will require some time to
collect new ephemerides and almanacs (around 15 minutes).

Clearing the NVRAM of your receiver will not delete any files
already recorded in your receiver’s memory; however, it will reset
your receiver to factory default values.

In addition, the NVRAM keeps information about the receiver file
system. Note that after clearing the NVRAM, the receiver's STAT
LED will flash orange for a few seconds indicating that the receiver is
scanning and checking the file system.

Using the MINTER to Clear the
NVRAM

Press the power key to turn off the receiver.
Press and hold the FN key.

Press and hold the power key for about one second. Release the
power key while continuing to hold the FN key.

4. Wait until the STAT and REC LEDs are green.
5. Wait until the STAT and REC LEDs blink orange.
6. Release the FN key while the STAT and REC LEDs blink orange.
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Using PC-CDU to Clear the NVRAM

1. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-16 for this procedure.

2. Click Tools » Clear NVRAM (Figure 4-16).

Initialize file system

Reset receiver [ g

Receiver options

Figure 4-16. Clear NVRAM with PC-CDU

While the NVRAM clears, the REC LED flashes green and red; the
STAT LED flashes red. The receiver automatically disconnects when
finished.

Changing Receiver Modes

The receiver has the following two information modes and one power
mode:

* Normal Mode — the standard surveying mode.

» Extended Information Mode — used for testing purposes during
normal operation.

» Sleep Mode — turns the receiver off but keeps it powered on in
“standby” and ready to activate via any input on a serial port.

Entering Extended Information Mode

Extended Information Mode (EIM) is used for receiver testing
purposes. In this mode, the receiver continues to work as usual, but
the STAT LED indicates “extended” information using a delimiter.

The delimiter is a distinguishable double-blink that shows the overall
status of tests performed in EIM. The STAT LED color for the
delimiter is calculated from the colors of other LED blinks and will
be one of the following colors when the test is complete:

* Orange — at least one blink is orange.

* Red — no orange blink and at least one red blink.
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¢ Green — all other cases.

The delimiter double-blink is followed by six LED blinks
corresponding to six receiver tests, where each blink indicates the

following information:

Blink 1.
Blink 2.
Blink 3.
Blink 4.

Blink 5.

Blink 6.

Sufficient data for position computation.
GPS S/N ratios are good (Table 4-2).
GLONASS S/N ratios are good (Table 4-2).

Oscillator’s frequency offset is less than three ppm (parts
per million).

Oscillator's Allan Variance is better than 2.7e-10

(currently, always orange).

Continuous tracking time is more than 15 minutes.

Table 4-2. Signal-to-Noise (S/N) “Good” Ratios

CA/L1

P/L1

P/L2

GPS

51

39

39

GLONASS

51

49

40

The color of the blink indicates that information for the test is
unavailable (orange), the receiver passed the test (green), or the
receiver failed the test (red).

1. To switch to EIM, press and quickly release the FN key three
times (within three seconds) on the MINTER.

2.  Watch for the delimiter double-blink. With good receiver,
antenna, and observation conditions, all blinks should be green

within 15 minutes of powering on.

¢ Green — ok

* Orange — wait

¢ Red — some tests failed

3. To switch back to normal mode, press the FN key three times
within three seconds.
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Sleep (Off) Mode

Sleep mode is the normal “off” state of the receiver.

1. Turn on your receiver.

2. Press the receiver’s power key for more than four seconds and
less than eight seconds. The STAT LED turns orange. The
receiver enters Sleep Mode.

3. Activity on a serial communication port will turn on the receiver.

; If you press the power key for more than 14
seconds, it will be ignored. This protects the
I

receiver operation against stuck keys.

Loading New Firmware

Use the latest firmware version, available for download from the TPS
website (www.topconpositioning.com), to ensure your receiver has
the most recent updates.

The Net-G3A receiver must be loaded with
firmware version 3.4 or newer.

@ Do not attempt to load firmware older than 3.4.

Receiver board firmware is released as a compressed file that you
download and decompress. This file contains the following two files:

* ramimage.ldr — the Receiver board RAM file
» main.ldp — the Receiver board Flash file

You must load all files when loading new firmware.
These files must come from the same firmware
package.
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The receiver uses FLoader, a Windows®-based utility, to load
firmware. You can download FLoader to your computer from the TPS
website at www.topconpositioning.com. For more information, refer
to the FLoader User’s Manual, also available on the Topcon website.
See “Installing FLoader” on page 2-7 for installing FLoader on the
computer.

1. If needed, download the new firmware package to your computer.

2. Connect your receiver and computer. See “Connecting the
Receiver and a Computer” on page 2-15 for this procedure.

3. Start FLoader.
On the Connection tab, select the COM port on your computer

that connects with your receiver and then select its speed (usually
115200) (Figure 4-17).

ETPE Firmware Loader: Device = Receiver o [l 3]

File Options Help

Connection I Device | Programl

Connection Type:

Connection Sething:

PC Poit: ICDM1 > | ‘wiord Length: |8 'l
Baud rate |11 5200 x| Paribye Mone 'l
Handshaking: INDnE ~| Stop Bits: 1 Vl

|25 02002 [16:08.11

Figure 4-17. FLoader Main Screen
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5. Click the Device tab, and then select Receiver from the Device
Type drop-down list.

ETF‘S Firmware Loader: Device = Receiver

File Options Help

Connection  Device IF‘rogramI

Device Type: Receiver 'l

Device Information

Model:

1D:

Firmivare
Hardware:
RAM Size, KB:

Savelofie I Cancel I

[31 Mar 2003 [17:532.44

Figure 4-18. Set Device Type

6. Click Get from Device for device information (Figure 4-18).

7. Click the Program tab, and select Soft Break Capture from the
Capture Method drop-down list (recommended) (Figure 4-19).

E TPS Firmware Loader; Device = Receiver
File ©ptions Help
Connection] Device Program ]
Capture Method: | Soft Break Capture -
Firmware:
@ R file: ‘C YFLoader_Firmwarehe2g3 3 4vramimage. dr j Browse B
@ Flash fle: |C:AFLoader_Fimnwaret=2g3_3_d'mein Idp | BrowseF
T Cancel |
Feady 03 Mar 2009 11:52,07

Figure 4-19. Program Tab Settings

8. Browse for and select the receiver board’s RAM file and Flash
file (Figure 4-19).

9. Click Load, and wait until every file loads into the receiver.

If you selected an incorrect file, an error message
@ displays at the bottom of the dialog box. Select the
correct file.
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10. Click File » Exit.

11. Clear the receiver’s NVRAM (see “Clearing the NVRAM” on
page 5-9) and update the almanac (see “Collecting Almanacs and
Ephemerides” on page 2-23) after loading new firmware.
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Troubleshooting

This chapter will help you diagnose and solve some common
problems you may encounter with your receiver.

ull

[WARNING )

Do not attempt to repair equipment yourself. Doing
so will void your warranty and may damage the
hardware.

Check This First!

Before contacting Topcon support, check the following:

* Check all external receiver connections carefully to ensure
correct and secure connections.

¢ Double check for worn or defective cables.

* Check all power sources.

* Check that the most current software is downloaded onto the
computer and that the most current firmware is loaded into the
receiver. Check the Topcon website at
www.topconpositioning.com for the latest updates.

Then, try the following:

* Reset the receiver using PC-CDU (Tools » Reset receiver).

* Restore default settings using PC-CDU (Configuration »
Receiver, and then click Set all parameters to defaults).

* Clear the NVRAM (see “Clearing the NVRAM” on page 4-18).

¢ Initialize the file system (click Tools » Initialize file system).
This erases all files inside the receiver.

If the problem persists, see the following sections for other solutions.
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Troubleshooting Quick List

For receiver power issues:

If “The receiver does not power up.” see page 5-2.

For receiver issues:

If “The receiver cannot establish a connection to a computer or
external controller.” see page 5-3.

If “The receiver does not lock on to satellites for a long period of
time.” see page 5-3.

If “The receiver tracks too few satellites.” see page 5-4.

If “The receiver cannot obtain Code Differential and/or RTK
solutions.” see page 5-4.

If “The receiver does not start data logging.” see page 5-6.

Powering Problems

The following are some of the most commonly encountered power
problems.

The receiver does not power up.

=

9-2

An external power source may be improperly connected.

* Check that the power source is correctly connected.

* Check that the power source contacts are clean and dust free.

The power source may be discharged (if a battery is used) or
may not provide enough power.

Connect/attach a fully charged battery or a correct power
supply and retry. See ‘“Powering the Receiver” on page 2-11.

If you are using an external power source, the cable may be
disconnected or damaged.

Check that the cable is securely connected and undamaged.
The receiver may have a defective power source.

Make sure that the external power source is working properly.
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Receiver Problems

The following are some of the most commonly encountered receiver
problems.

The receiver cannot establish a connection to a computer or
external controller.

Cable specific problems:
= The cable is not properly plugged in.
* Check that the cable connector is attached to the correct

receiver port.

* Unplug the cable, and then securely and properly reconnect
it to the receiver.

* See “Net-G3A Receiver” on page 1-8 and “Connector
Specifications” on page A-9 for information about the
receiver’s connectors.

= The cable is damaged.

Use an undamaged cable. Contact your Topcon dealer to
replace the cable.

Generic problems:
> The receiver port used for connection is not in Command mode.

1. Connect your receiver and a computer using a free port
(see “Connecting the Receiver and a Computer” on
page 2-15) and start PC-CDU.

Click Configuration » Receiver » Ports.

3. Change the Input for the port used for connection to
Command.

The receiver does not lock on to satellites for a long period of
time.

= The receiver stores an old almanac.

Update the almanac. See “Collecting Almanacs and
Ephemerides” on page 2-14 for details.
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= The corresponding receiver options may be disabled or expired
(L1/L2, GPS/GLONASS must be on to track satellites).
* See “Managing Receiver Options” on page 4-14 for details
about how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the Topcon website at
www.topconpositioning.com for details.

» Refer to the PC-CDU Reference Manual for a detailed
description of options.
The receiver tracks too few satellites.

= The elevation mask value is too high (above 15 degrees).

Lower the elevation mask. See page 3-5 for information
about setting the elevation mask.

= The survey is conducted near obstructions (tree canopy, tall
buildings, etc.).
* Check that the Multipath Reduction boxes have been
enabled.

1. Connect your receiver and a computer and start
PC-CDU. See “Connecting the Receiver and a
Computer” on page 2-15.

2. Click Configuration » Advanced and the
Multipath Reduction tab. Enable the two boxes, and
click Apply.

* Move to an area free of obstructions, if applicable.

The receiver cannot obtain Code Differential and/or RTK
solutions.

= Incorrect Base coordinates entered.

Specify the correct coordinates for the Base station using
PC-CDU or another suitable field data collection software.

5> The receiver is not configured as a Base or Rover.
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Receiver Problems

e If the receiver should function as a Base, ensure it has the
proper configuration. See “Configuring the Receiver” on
page 3-2 for details.

e If the receiver should function as a Rover, ensure it has the

proper configuration. See “Configuring the Receiver” on
page 3-2 for details.

= The corresponding receiver options may be disabled or expired.

* See “Managing Receiver Options” on page 4-14 for details
on how to check current options.

* Order a new OAF with the desired options activated to
enable or extend validity of the corresponding receiver
options. Contact your dealer or visit the Topcon website at
www.topconpositioning.com for details.

* Refer to the PC-CDU Reference Manual for a detailed
description of options.

= There are not enough common satellites. In order to obtain a
fixed solution, the Base and Rover should track at least five
common satellites.

* Ensure that both the Base and Rover receivers use the same
updated almanac. See “Collecting Almanacs and
Ephemerides” on page 2-14.

¢ Check the elevation masks of the Rover and Base receivers;
they should be the same. See page 3-5 for information
about setting the elevation mask.

= A discrepancy exists between the differential standards used at
the Base and Rover receivers.

Ensure the Base and Rover receivers use the same corrections
input/output format:

1. Connect your receiver and a computer, and start PC-
CDU. See “Connecting the Receiver and a Computer” on
page 2-15.

2. Click Configuration » Receiver and the Ports tab. Use
the same input/output format for both receivers.
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Troubleshooting

= Poor satellite geometry (PDOP/GDOP values are too high).
Conduct your survey when PDOP values are low.
= The elevation mask is above 15 degrees.

Lower the elevation mask. See page 3-5 for information on
setting the elevation mask.

The receiver does not start data logging.

= The receiver has no memory card installed or the memory
option is disabled or expired.

* Check that the card is properly inserted. For details, see
“Installing the CF Card” on page 2-8.

* Check that the memory option is enabled. For details, see
“Checking the Receiver’s OAF” on page 4-14.

> The receiver’s memory card has no free space.

* Download and/or delete data files to free up space for new
files (see “Downloading Data Files from an Installed
Memory Card” on page 4-1 and “Deleting Data Files from
an Installed Memory Card” on page 4-8).

e Use the AFRM feature. See “Automatic File Rotation
Mode (AFRM) parameters” on page 3-12.
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Obtaining Customer Support

Obtaining Customer Support

Before contacting Topcon customer support about any problems with
the receiver, consult your local Topcon dealer and also see “Check
This First!” on page 5-1 for some solutions that may fix the issue.

If, after taking the above steps, you still need assistance, contact
Topcon customer support.

Phone

To contact Topcon customer support by phone, call:

1-866-4TOPCON (1-866-486-7266)
Monday through Friday
8 am to 8 pm, Eastern Standard time

To contact Topcon customer support via e-mail, use
TopconTechnicalSupport@topcon.com.

N For quick and effective support, provide a detailed
description of the problem.

When e-mailing Topcon customer support, provide the following
information for better, faster service:

1. The receiver model and configuration settings.

In PC-CDU, click Help » About and then click Save to file.
Enter a file name and save it to your computer. Attach this file to
the email.

2. The system/hardware specifications for the computer running the
Topcon software, such as operating system and version, memory
and storage capacity, processor speed, etc.

3. The symptoms and/or error codes/messages that precede and
follow the problem.
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Troubleshooting

4. The activities being tried when the problem occurs. If possible,
include the exact steps being taken up to when the error message
or other problem occurred.

5. How regularly the problem occurs.

Generally, a customer support representative will reply within 24
hours, depending on the severity of the problem.

Website

The Topcon Positioning Systems website provides current
information about Topcon’s line of products. The support area of the
website provides access to frequently asked questions, configuration
procedures, manuals, e-mail support, etc.

To access the Topcon website, visit www.topconpositioning.com
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Specifications

This Topcon product is a 144-channel GNSS receiver with an
optional, removable CF memory card, a rugged aluminum housing
complete with MINTER and cable connectors.

GPS satellites above 15 degrees in elevation and
adherence to the procedures recommended in this
manual.

@ Performance specifications assume a minimum of 6

In areas of high multipath, during periods of large
PDOP, and during periods of increased ionospheric

Use robust checking procedures in areas of extreme
multipath or under dense foliage.

activity, performance may degrade.
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Specifications

Net-G3A Dimensions

Figure A-1 shows the measurement dimensions for the Net-G3A
receiver, including the placement of the screw holes.

= Dimensions are in inches.

4X ©0.135
1.244 L] 8s2UNC

11.0 6.693

Figure A-1. Net-G3A Dimensions

Use these dimensions when drilling holes into a permanent mount,
using four #8-32 screws to attach the receiver.
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Receiver Specifications

Receiver Specifications

The following sections provide specifications for the receiver and its
internal components.

General Details

Table A-1 table lists the receiver’s general specifications.

Table A-1. Receiver General Specifications

Physical
Enclosure Aluminum, IP67 rated extrusion
Color Topcon Yellow and Topcon Grey
Dimensions W:166 mm x H:93 mm x D:275 mm
6.54" x 3.66" x 10.83"

Weight 3.0 kg (6.61 Ibs)
Antenna External
Controller External MINTER
Keys Two keys:

Power — On/Off

FN — start/stop data logging; switch information mode
LEDs Six LEDs:

STAT - satellite and receiver status

REC - record and data status

RX TX — modem status

LINK - network connection status (currently n/a)
PWR x 2 — power status

Environment

Operating
temperature

-40 C° to +65 C°

Storage temperature

-40 C° to +75 C°

Humidity

100% non-condensing

IP rating

[P67 waterproof/dustproof
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Table A-1. Receiver General Specifications (Continued)

Power
External power 2 ports
Input voltage 61028 VDC

Consumption 4.5 W typical
5 W maximum

On-board Backup battery for timekeeping and almanac data storage;
10 years minimum operation; two internal batteries for up
to 25 hours of emergency operation.

/0

Communication 4 high speed RS232 serial ports (1xODU-MINI-SNAP,

Ports 3xDE-9)

1 USB port (Mini-B)
1 USB port (Type A)
1 Ethernet port (RJ45)

Port specifications

RS232 serial port
Baud rate: 460800,230400,115200(Default),57600,
38400,19200,9600,4800,2400,1200,600, 300
Flow control: RTS/CTS
Length: 7,8 (default)
Stop bit: 1 (default), 2
Parity: None (default), Odd, Even
USB port
Full speed: 12 Mb/s
Ethernet port
10.100 Mb, Half/Full Duplex

Connectors 2x PWR, 4x RS232 Serial, USB Host/Device, Ethernet,
GPS antenna, 1PPS, Event Marker, Ext. Frequency

MINTER Six external LEDs (see “LEDs” on page A-3 for details)
ON/OFF control input (power button)
Data logging control (FN button)

Technology

Advanced Multipath mitigation
SBAS

Adjustable PLL and DLL parameters
Anti-Jamming Suppressor (AJS)

A-4
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Table A-1. Receiver General Specifications (Continued)

Data Features

Up to 50 Hz update rate for real time position and raw
data (code and carrier)

10cm code phase and 0.1mm carrier phase precision
RTCM SC104 version 2.1, 2.2, 2.3, and 3.0 I/O
Multiple Base RTCM

Geoid and Magnetic Variation models

Different DATUMs support

Output of grid coordinates

CMR and CMR+ support

NMEA
NMEA version Ver. 2.1,2.2,2.3, 3.0, 3.01 output
Messages GGA, GLL, GMP, GNS, GRS, GSA, GST, GSV, HDT,

RMC, ROT, VTG, ZDA, UID and P_ATT

Output interval

1Hz standard; 5, 10, 20, and 50 Hz optional

DGPS

Correction format

RTCM SC104 Ver 2.1,2.2,2.3

RTCM message
type

1, 3,9, 31, 32, 34; user selectable

Process interval

1Hz standard; 5, 10, 20, 50 Hz optional

Output interval for
RTCM correction
data

1Hz standard; 5, 10, 20, 50 Hz optional

Elevation mask

0 to 90 deg (independent of data logging)

Multi-base DGPS

Differential correction select mode: Nearest, Mix, Best
(optional)

RTK

Correction formats

CMR/CMR+ (Trimble compatible); RTCM SC104 Ver
2.2,2.3,0r3.0; TPS

RTCM message
type

3,18, 19, 20, 21, 22, 23, 24 by rover; 3, 18, 19, 22, 23,24
by base; user selectable
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Table A-1. Receiver General Specifications (Continued)

Ambiguity initialize | OTF (L1, L1/L2) and known point initialization

Initialize time 5 seconds to 10 min depending on the base line length and
multipath conditions

Output interval for 1Hz standard; 5, 10, 20, 50 Hz optional
CMR/RTCM

Elevation 0 to 90 degrees (independent of data logging)

Solution mode Delay (synchronization)
Extrapolation (not synchronized)

Process interval 1Hz standard; 5, 10, 20, 50 Hz optional

Latency Delay mode — 20 msec to 20 sec (depends on latency,
which receives corrections data from the base receiver)
Extrapolation — 20 to 30 msec

Raw Data logging Receiver can record raw data at another interval during
RTK operation

Status Fix, Float, DOP, Data Link Status, Modem Latency,
Common satellites, Percentage of fixing

Results RTK coordinates, HRMS, VRMS, Covariance Matrix

Ambiguity fixing Selectable thresholds
level Low: 95%; Medium: 99.5%; High: 99.9%

Survey Modes

Base Static

Rover (optional) Kinematic (Stop and Go)
RTK (Real-time Kinematic)
DGPS (Differential GPS)
WASS/EGNOS DGPS

Survey Accuracy

Static, Fast Static For L1+L2 — H: 3mm + 0.5ppm (x baseline length);
V: Smm + 0.5ppm (x baseline length)

Kinematic, RTK For L1+ L2,L1 —H: 10mm + 1.0ppm (x baseline length);
V: 15mm + 1.0ppm (x baseline length)
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Table A-1. Receiver General Specifications (Continued)

DGPS Post processing: less than 0.25m (HRMS)
DGPS/RTCM based: less than 0.25m (HRMS)

Cold Start < 60 sec

Warm Start < 10 sec

Reacquisition <1 sec

GNSS Board Details

Table A-2 lists the GNSS board’s general specifications.

Table A-2. GNSS Board Specifications

Receiver Type (set by activating the proper OAF)

Internal board:
E2G3

GPS: L1 (C/A & P),L2,L2C, L5

GALILEO?

GLONASS: L1, L2 (both code and phase)

Tracking Specifications

and Carrier, WAAS/EGNOS

Standard Channels 144 universal channels (G, GG, GD, GGD)
Optional Cinderella days (see page A-8 for details)
Tracked Signals GPS/GLONASS, L1/L.2 C/A, L5, GALILEO, and P-Code

Tracking Functions

Multi-path C/A Code phase and Carrier phase
reduction
PLL/DLL setting Bandwidth, order, adjustable

Smoothing interval | Code; user selectable

SBAS WAAS optional; EGNOS optional

Data Features

Formats

TPS, NMEA, RTCM, CMR, BINEX
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Table A-2. GNSS Board Specifications (Continued)

Features Up to 50 Hz update rate for real time position and raw
data (code and carrier)

10cm code phase and 0.1mm carrier phase precision
RTCM SC104 version 2.1, 2.2, 2.3, and 3.0 I/O
Multiple Base RTCM

Geoid and Magnetic Variation models

Different DATUMSs support

Output of grid coordinates

CMR and CMR+ support

Memory

Internal Memory CF card, removable

Capacity Dependent on capacity of the installed CF card, currently
up to 2 GB. The capacity is extended by several hundred
gigabytes when using a mass storage device connected to
the USB host.

Logging Size 3.5 MB per hour (18 SVs, 1sec, L1/L2, default message
set)

Logging Interval 0.01 to 86400 seconds, depending on purchased options

a. Contact Topcon Technical Support for detailed information about the
supported GALILEO signals.

Cinderella days is an option that turns a single frequency, GPS
receiver into a dual-frequency, GPS+GLONASS receiver for 24 hours
every other Tuesday at GPS midnight. Refer to Topcon’s website at
www.topconpositioning.com for more information and specific
Cinderella day dates.
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Connector Specifications

The Net-G3A has the following connectors:

e Power x 2

Power Connector

Serial RS232C: 1xODU and
3xDE-9

USB Host/Device
e Ethernet

e GPS antenna
* 1PPS
¢ Event marker

» External Frequency

The power connector (Figure A-2) is a sealed receptacle, 5 pin, ODU
part number G8OF1C-T05QF00-0000.

P —

@
o 2 |

Figure A-2. Power Connector

Table A-3 gives power connector specifications.

Table A-3. Power Connector Specifications

Number Signal Name Dir Details
1 Power_INP P 6 to 28 volts DC input
2 Power_INP P 6 to 28 volts DC input
3 Power_GND P Ground, power return
4 Power_GND P Ground, power return
5 Aux_Power P 6 to 28 volts DC input
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Serial RS232C Connectors

The front panel serial RS232 connector (Figure A-3) is a sealed
receptacle, 7 pin, ODU part number G8OF1C-T07QC00-0000.

Figure A-3. Serial RS232 Connector

Table A-4 gives the RS232 cable connector specifications.

Table A-4. RS232 Connector Specifications

Number Signal Name Dir Details
1 Ext PWR (0] 6 to 28 volts DC output at max
load 0.5 A
2 GND - Signal ground
3 CTS I Clear to send
4 RTS (0] Request to send
5 RXD 1 Receive data
6 TXD (6] Transmit data
7 Not used

The back panel serial RS232 connectors (Figure A-4) are a sealed
receptacle, 9 pin, D-shell connector.

O oo | O
o O O O

Figure A-4. Serial RS232 Connector
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Table A-5 gives the RS232 cable connector specifications.

Table A-5. RS232 Connector Specifications

Number Signal Name Dir Details
1 Not used
2 RXD I Receive data
3 EXD o Transmit data
4 Not used
5 GND Signal ground
6 Not used
7 RTS (0] Request to send
8 CTS I Clear to send
9 Not used

Ethernet/USB Connector

The Ethernet/USB connector is a 12-pin ODU-MINI-SNAP
(Figure A-5).

Figure A-5. Ethernet Connector
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Table A-6 gives Ethernet/USB connector specifications.

Table A-6. Ethernet/USB Connector Specifications

Number Signal Name Dir Details
1 LAN TXD+ (0] Transmit data plus
2 LAN TXD- o Transmit data minus
3 LAN RXD+ 1 Receive data plus
4 LAN RXD 1 Receive data minus
5 USB_PWR_HOST P Power to the UMS device
6 USB_HOST_D- I/0 Data minus
7 USB_HOST_D+ /0 Data plus
8 GND - Signal ground
9 USB_D- I/O Data minus
10 USB_D+ /0 Data plus
11 GND - Signal ground
12 USB_PWR P Bus power input

GPS Antenna Connector

The external antenna connector type is a N-type connector.

Table A-7. External GPS Antenna Connector Specifications

Type

Signal Name

Dir

Details

TNC

Ant_IN

RF input from LNA, 60 mA at
5.0 volts
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1PPS Connector

The 1PPS connector is a coaxial female receptacle of BNC series,
Kings Electronics part number KC-79-108.

Table A-8. 1PPS Connector Specifications

Connector BNC female

Polarity Positive Pulse

Signal level >=2V, TTL into 50 Ohm load

Pulse Width 3.3 msec (normal pulse); 5.2 msec (marked pulse)
Rise Time <=3 nsec

Fall Time <=3 nsec

Synchronization Rising/Falling (user selectable)

Edge

Resolution 5 nsec

Period 10 to 1000000000 msec

Offset -500000000 to 500000000 msec; -500000 to 500000 nsec

Reference time

GPS, GLONASS, UTC (USNO), UTC (SU)

Event Marker Connector

The Event Marker connector is a coaxial female receptacle of BNC
series, Kings Electronics part number KC-79-108.

Table A-9. Event Marker Connector Specifications

Connector BNC female

Polarity Positive/Negative Pulse
Logical DC voltage | Low “0” from -40 V to +0.8 V
levels High “1” from +1.4 Vto +40 V

Input impedance

2 kOhm for-40 VtoO Vand +3.3 Vto+40 V
>100 kOhm for 0 Vto +3.3 V
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Table A-9. Event Marker Connector Specifications (Continued)

Pulse Width >= 100 nsec

Synchronization Rising/Falling (user selectable)

Edge

Resolution 5 nsec

Reference time GPS, GLONASS, UTC (USNO), UTC (SU)

External Frequency Connector

The External Frequency connector is a coaxial female receptacle of
BNC series, Kings Electronics part number KC-79-108.

Table A-10. External Frequency Connector Specifications

Output

Connector | BNC; 50 Ohm impedance

Frequency | 20 MHz

Amplitude | 0.6 Vp-p into 50 Ohm

Waveform | Sine wave

Harmonics | -19 dBc

Spurious | -70 dBc

Input

Connector | BNC; 50 Ohm impedance

Frequency | 5/10/20 MHz

Sensitivity | 0.5...3 Vp-p into 50 Ohm
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CF Cards Compatible with the Net-G3A

CF Cards Compatible with the

Net-G3A

The following CF cards have been successfully tested with the

Net-G3A and can be safely used with the receiver. Before using any
other CF cards, consult with Topcon customer support about

compatibility.

Table A-11. Net-G3A CF Cards Compatibility List

Capacity (MB) Topcon part number Manufacture part number
SanDisk

16 22-006011-16 SDCFBI-16-101

32 22-006011-32 SDCFBI-32-101
SDCFBI-32-201-00
SDCFBI-32-201-00

64 22-006011-64 SDCFBI-64-101
SDCFBI-64-201-00

80 22-006011-80 SDCFBI-80-101

96 22-006011-96 SDCFBI-96-101

128 22-006011-128 SDCFBI-128-101
SDCFBI-128-201-00

160 22-006011-160 SDCFBI-160-101

192 22-006011-192 SDCFBI-192-101

256 22-006011-256 SDCFBI-256-201-00

512 22-006011-512 SDCFBI-512-201-00

1024 22-006011-001 SDCFBI-1024-201-00
SDCFX3-002G-A21

2048 22-006011-002 SDCFH-002G-Al11
SDCFX4-2048-901

SiliconSystems
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Table A-11. Net-G3A CF Cards Compatibility List (Continued)
Capacity (MB) Topcon part number Manufacture part number
32 22-006011-32 SSD-C32MI-3012
128 22-006011-128 SSD-C12MI-3012
256 22-006011-256 SSD-C25MI-3012
512 22-006011-512 SSD-C51MI-3012
1024 22-006011-001 SSD-C01GI-3012
White Electronics Designs
128 22-006011-128 WED7P128CFA7000125
256 22-006011-256 WED7P256CFA7000125
512 22-006011-512 WED7P512CFA7000125
1024 22-006011-001 WED7P1G0CFA7000125
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Safety Warnings

General Warnings

ull

[WARNI

N

TPS receivers are designed for survey and survey
related uses (that is, surveying coordinates,
distances, angles and depths, and recording such
measurements). This product should never be used:

* Without the user thoroughly understanding this
manual.

* After disabling safety systems or altering the
product.

* With unauthorized accessories.
» Without proper safeguards at the survey site.

* Contrary to applicable laws, rules, and
regulations.

ST

TPS receivers should never be used in dangerous
environments. Use in rain or snow for a limited
period is permitted.
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Safety Warnings

Usage Warnings

If this product has been dropped, altered,

@ transported or shipped without proper packaging, or
otherwise treated without care, erroneous
measurements may occur.

The owner should periodically test this product to

ensure it provides accurate measurements.

Inform TPS immediately if this product does not
function properly.

Only allow authorized TPS warranty service centers
to service or repair this product.
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FCC Compliance

Regulatory Information

The following sections provide information on this product’s
compliance with government regulations for use.

FCC Compliance

This device complies with Part 15 of the FCC rules. Operation is
subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including
interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits
for a digital device, pursuant to Part 15 of the FCC rules. These limits
are designed to provide reasonable protection against harmful
interference in residential installations. This equipment generates,
uses, and can radiate radio frequency energy, and if not installed and
used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation.

If this equipment does cause interference to radio or television
equipment reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that
to which the receiver is powered.

» Consult the dealer or an experienced radio/television technician
for additional suggestions.

P/N 7010-0935 c-1



Regulatory Information

Any changes or modifications to the equipment not
@ expressly approved by the party responsible for

compliance could void your authority to operate
such equipment.

Community of Europe
Compliance

The product described in this manual is in compliance with the
R&TTE and EMC directives from the European Community.

WEEE Directive

Following information is for EU-member states only:

The use of the symbol indicates that this product may not be treated
as household waste. By ensuring this product is disposed of correctly,
you will help prevent potential negative consequences for the
environment and human health, which could otherwise be caused by
inappropriate waste handling of this product. For more detailed
information about the take-back and recycling of this product, please
contact your supplier where you purchased the product or consult.
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Warranty Terms

TPS laser and electronic positioning equipment are guaranteed
against defective material and workmanship under normal use and
application consistent with this Manual. The equipment is guaranteed
for the period indicated, on the warranty card accompanying the
product, starting from the date that the product is sold to the original

purchaser by TPS’ Authorized Dealers.!

During the warranty period, TPS will, at its option, repair or replace
this product at no additional charge. Repair parts and replacement
products will be furnished on an exchange basis and will be either
reconditioned or new. This limited warranty does not include service
to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized TPS warranty
service dealer. If this product is delivered by mail, purchaser agrees to
insure the product or assume the risk of loss or damage in transit, to
prepay shipping charges to the warranty service location and to use
the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/
or defect.

The purchaser’s sole remedy shall be replacement as provided above.
In no event shall TPS be liable for any damages or other claim
including any claim for lost profits, lost savings or other incidental or
consequential damages arising out of the use of, or inability to use,
the product.

1. The warranty against defects in a Topcon battery, charger, or cable is 90
days.
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Notes:
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AFRM 3-12, 5-6
Almanac
broadcast data 2-14
collect 3-25
definition 2-14
update 2-14, 4-24, 5-3
Always append to file 3-12
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cabling system 3-20
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install 1-16, 2-8
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Clear NVRAM 4-24
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using USB cable 2-17
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GPS antenna port 1-15

|

Information mode
EIM 4-19
sleep 4-21

STAT LED 4-19

Initial data collection dynamic mode 3-

14
Install
FLoader 2-7

Index

PC-CDU 2-6
SD/CF card 2-8
Topcon software 2-5-2-7
USB driver 2-15
Internal antenna offset 3-24

L

LED
LINK 1-9
PWR 1-10
REC blink pattern 1-11
RXTX 1-11
STAT 1-9
LINK LED 1-9
blink pattern 1-9
Load firmware 4-21-4-24

Memory 2-8

size of log files 4-10
MINTER

configure 3-9, 3-10

functions 3-9

parameters 3-10, 3-11-3-14
Mounting holes 1-18
Multi-frequency 1-1

Navigation message 2-14
See also Almanac
See also Ephemeris, definition
NVRAM
almanac and ephemerides 2-14
clear 4-24
update almanac 2-14

o

OAF 1-21

update almanac 2-14
Offsets, internal antenna 3-24
OmniSTAR, DGPS overview 1-4
Option authorization file
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See OAF
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PC-CDU 2-6, 2-24
computer requirements 2-6
configuration 3-3-3-8, 3-10, 3-

15
install 2-6
manage power 2-24
uninstall 2-7
version requirements 2-6

Phase center 3-24

Port
Ethernet 1-15
event 1-15
external frequency 1-15
GPS antenna 1-15
NET-G3 back 1-14
NET-G3 front 1-15
power 1-15
PPS 1-15
serial, back 1-14
serial, front 1-15

Port A 1-14

Power 2-4
on/off 2-13
ports 2-4
switch 2-4

Power button 1-11

Power port 1-15

Power status 2-12
via PC-CDU 2-12, 2-24

PPS port 1-15

PWR LEDs 1-10, 2-12
blink pattern 1-10
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RAM file 4-21, 4-23
REC LED
and FN button 1-12
blink pattern 1-11, 1-12
Receiver modes 4-19
See also EIM
See also Normal Mode
extended 4-19-4-20
sleep mode 4-21
Recording interval 3-11
Reference station
temporary 3-21
Remove CF card 2-9
RS232 connection parameters 2-22
RTK 1-5
RX TX LED 1-11

S

SD/CF card, install 2-8
Serial number 3-4
Serial port 1-14, 1-15
Serial port A 1-14
Set baud rate, 115200 2-22, 4-22
Sleep mode 4-21
Software 2-5
FLoader 2-7
PC-CDU 2-6, 3-3-3-8, 3-10, 3-
15
Topcon Link 4-7
TopNET 1-9, 2-5, 3-1, 3-2
STAT LED 1-9, 4-19
blink pattern 1-9, 4-19-4-20
EIM 4-19
green 1-9
orange 1-9
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red 1-9
Static survey 3-26
Survey 3-26

T

Temporary reference station 3-21
Test 4-19, B-2

EIM 4-19-4-20
Topcon Link 2-5
Topcon Link, download files 4-7
TopNET, configure receiver 3-2

U

Uninstall
FLoader 2-7
PC-CDU 2-7
USB connection parameters 2-22
USB driver 2-15
USB port 1-15

W

Warnings B-1
general B-1
usage B-2

Web interface 3-18
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